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Notice

AJA®, KONA®, Ki Pro” and XENA”® are registered trademarks of AJA Video, Inc. lo HD",

lo Express™, and lo™ are trademarks of AJA Video, Inc. Apple, the Apple logo, AppleShare,
AppleTalk, FireWire and Macintosh are registered trademarks of Apple Computer, Inc. Final
Cut Pro, QuickTime and the QuickTime Logo are trademarks of Apple Computer, Inc.
TASCAM is a registered trademark of TEAC Corporation.

All other trademarks are the property of their respective holders.

Copyright © 2010 AJA Video, Inc. All rights reserved. All information in this manual is subject
to change without notice. No part of the document may be reproduced or transmitted in
any form, or by any means, electronic or mechanical, including photocopying or recording,
without the express written permission of AJA Inc.

FCC Emission Information

Contacting Support

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense. Changes or modifications not expressly approved by
AJA Video can effect emission compliance and could void the user’s authority to operate
this equipment.

To contact AJA Video for sales or support, use any of the following methods:
180 Litton Drive, Grass Valley, CA. 95945 USA

Telephone: 800.251.4224 or 530.271.3190
Fax: 530.274.9442

Web: http://www.aja.com
Support Email: support@aja.com
Sales Email: sales@aja.com

When calling for support, first read the Chapter on Troubleshooting at the back of this
manual. You can often save time and effort by looking there first for simple remedies and
information on how to get support from AJA.
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Limited Warranty

AJA Video warrants that this product will be free from defects in materials and
workmanship for a period of three years from the date of purchase. If a product proves
to be defective during this warranty period, AJA Video, at its option, will either repair
the defective product without charge for parts and labor, or will provide a replacement
in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify AJA Video
of the defect before the expiration of the warranty period and make suitable
arrangements for the performance of service. The Customer shall be responsible for
packaging and shipping the defective product to a designated service center
nominated by AJA Video, with shipping charges prepaid. AJA Video shall pay for the
return of the product to the Customer if the shipment is to a location within the
country in which the AJA Video service center is located. Customer shall be responsible
for paying all shipping charges, insurance, duties, taxes, and any other charges for
products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use
or improper or inadequate maintenance and care. AJA Video shall not be obligated to
furnish service under this warranty a) to repair damage resulting from attempts by
personnel other than AJA Video representatives to install, repair or service the product,
b) to repair damage resulting from improper use or connection to incompatible
equipment, ¢) to repair any damage or malfunction caused by the use of non-AJA Video
parts or supplies, or d) to service a product that has been modified or integrated with
other products when the effect of such a modification or integration increases the time
or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY AJA VIDEO IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. AJA VIDEO AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. AJA VIDEO’S
RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER AJA VIDEO OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Chapter 1: Introduction

KONA 3 - SD, HD, Dual Link, HSDL KONA LHi - SD, HD, HDMI, Analog KONA LSe - SD, Analog

Overview

XENA Compatibility

The AJA KONA series brings the highest quality 2K, HD, and SD video and audio to a Windows
workstation. This manual discusses the KONA for PC software plug-ins that provide powerful
features to Windows video applications. Although this manual is written for the Windows
plug-ins, it also applies to AJA Mac Plug-ins for Adobe which run under OSX Snow Leopard
(the screens and functions are mostly identical).

For owners of AJA’'s XENA capture cards, the KONA for PC software fully supports XENA
hardware. The XENA product line has been folded into our award-winning KONA line., to
supply both PC and Mac users with a single set of cross-platform solutions. XENA and KONA
have long used the same industry-leading hardware with tailored software unique to each
platform. To add value for customers, we are now packaging each KONA card with both Mac
and PC software, so they can be used on either platform—or both. The hardware and
software are the same. The name and package has changedto provide twice the software and
ease-of-use on all platforms.

The following table provides XENA-to-KONA model name changes.

XENA-to-KONA Model Compatibility

XENA Model KONA Equivalent

XENA 2Ke KONA 3

XENA 2K KONA 3x
XENA LHi KONA LHi
XENA LHe KONA LHe
XENA LH KONA LH
XENA LSe KONA LSe
XENA LS KONA LS
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Applications
Supported

Capture Formats

DVCProHD Support

Note: Due to the product line name change, XENA users will find product support on our
website under “KONA for PC!" Support and offerings remain the same—uwith the best
quality and level of support in the industry.

With KONA Software version 5.0 for PC’s professional features, you can run these Windows
platform applications (application software not included).

* Adobe Premiere Pro CS5

* Adobe After Effects CS5

* Adobe Photoshop CS5

* Autodesk Combustion 2008
* Eyeon Fusion 6.x (64-bit only)

KONA for PC software also offers AJA's own Machina software for incredible standalone file
capture, preview and playout with full machine control. Third-party native support for
KONA cards is also available in applications such as Avid Liquid Chrome, Sony Vegas, and
Sonic CineVision (see “Native Support for KONA for PC Products ” on page 107).

KONA version 5.0 software and plugins are also compatible with the Bootcamp Windows
environment on Macintosh machines running OSX Snow Leopard or better. (Beta versions
of Bootcamp are not supported.)

Some KONA card models are available in both PCI-X compatible and PCl-e bus versions (LHi
is PCle only). KONA cards offer high-quality digital and analog interfaces for use in
broadcast, editing and graphics/animation work. The KONA 3/3x card can capture SDI, HD-
SDI, Dual Link 4:4:4 HD-SDI, and HSDL. KONA LHi captures analog and digital HD/SD data
and also supports HDMI in and out. KONA LS is for analog and digital SD data only.

When capturing, you can record data in the following file formats:
* DPX (LHi & 3Ke/3K only)
¢ Cineon (LHi & 3Ke/3K only)
*TGA
* TIFF
* BMP
* YUV
* AVI
* QuickTime

* MXF MPEG (Sony Vegas only)

KONA cards also include a DVCProHD Library that enables users to capture, edit, and play
back DVCProHD compressed QuickTime files in KONA for PC supported applications.

For more information on using DVCProHD for:

* Compressed Online Editing,

* Compressed Offline Editing,

* Import, Editing, and Playing Multiple Media Types,

* Cross-Platform Workflow with KONA and DVCProHD
Please see the whitepaper DVCProHD Editing with KONA at:

http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf
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KONA 3/3x Features

Dual Link

KONA 3 Workflow

Introduction — KONA 3/3x Features

This manual covers the installation and operation of KONA LSe/LS, KONA LHi, and
KONA 3/3x models and discusses using them with supported applications. Instructions
for installing the optional breakout boxes are shipped with the option.

Note: Except where noted in this manual, references to KONA LS and KONA 3 also
include the LSe and 3x models.

The KONA 3 card supports the popular uncompressed SD or HD formats including 2K and
Dual Link 4:4:4 HD-SDI formats. It captures uncompressed 10-bit and 8-bit digital video
and 24-bit 48 kHz digital audio in Standard definition (SMPTE 259M), High definition
(SMPTE 292M), and Dual Link High Definition (SMPTE 372M).

KONA 3 features include:

* SDI, HD-SDI, Dual Link SD and HD-SDI, and HSDL
* KONA software plugins and support for third-party applications
* AJA’s standalone Machina capture/playback software

* Native support for uncompressed DPX, Cineon, TGA, TIFF, BMP, YUV, and AVl and
QuickTime files

* Support for 2K frame formats

* Support for Cineform 3D playback with left/right stereoscopic output on separate
outputs

* Look Up Table support (LUT)

* 4-lane PCl-express bus interface (KONA 3)
or PCI-X 133 interface (KONA 3x)

* Broadcast-quality hardware 10-bit up-convert, down-convert and cross-convert.
¢ 12-bit HD component and SD component/composite analog output

¢ 16-channel SDI embedded audio and 8-channel 48/96 kHz AES audio

* RS-422 machine control

* Cables standard, K3-Box breakout optional

KONA 3 supports Dual Link 4:4:4 HD-SDI. KONA 3 Dual Link supports full-bandwidth 4:4:4
RGB at 10-bits (12-bit capable) for 1080i, 1080p, and 720p formats. KONA 3 can also
convert between 4:4:4 and 4:2:2 formats for Single Link HD-SDI output.

The KONA 3 path allows you to go straight from telecine to disk with 2K media
eliminating the steps of using tape stock and then digitizing those tapes for the nonlinear
editor. KONA 3 capture from 2K telecine directly creates 2K DPX, QuickTime, Cineon, AV,
TGA, TIFF, or BMP files. Material can be played out at 2K via HSDL (High Speed Data Link)
at 15 fps.

KONA 3 allows 2K files to be viewed on HD 1080 24P-supported video monitors. This 1080
HD playout can also be down-converted to SD in realtime, giving the 2K DI pipeline a
solution for multi-format video playout of 2K material.

By generating 2K files directly from a Telecine in a multitude of file formats and bit-
depths, you have files available for use on any system and at any stage in production. A
colorist, effects artist, and editor can immediately use the files.

KONA 3 supports any popular uncompressed SD or HD format, including Dual Link and
2K and captures and plays back uncompressed 10-bit and 8-bit digital video. KONA 3 also
includes a variety of 10-bit broadcast-quality features—hardware-based up-, down-, and
cross-conversion to and from HD.
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Broadcast-quality
Conversion

Video + Key SDI
output

KONA 3 Audio

KONA31/0

KONA 3 is available in two models. KONA 3x uses the PCI-X 133 interface while KONA 3 is a
4-lane PCl-express bus card. The two cards are identical in features and video and audio
connections and use the same optional K3-Box breakout box.

KONA 3 features full 10-bit, broadcast-quality, SD-to-HD up-conversion, HD- to-SD down-
conversion, SD and HD cross-conversion, and automatic HD/SD 12-bit component analog
output. The quality is identical to AJA’'s stand-alone products and all functionality is
hardware-based making it available all the time on digitize or playback. KONA 3 offers
hardware-based 1080-to-720 or 720-to-1080 cross-conversion further streamlining dailies
and deliverables creation at true broadcast picture quality in realtime. For maximum
flexibility, hardware-based aspect ratio conversion can be applied to standard definition
capture and output.

This feature is available on the output settings in Machina, After Effects, and Premiere Pro.
To use Video + Key, set the SDI-1 Output to ‘Video + Key (V) or ‘Video + Key (K)' The SDI-2
then output automatically changes to the complimentary setting.

Note: Video + Key is limited to 8-bit RGBA files.

KONA 3's extensive audio support makes installation simple, working with 8-channel
24-bit 48 and 96 kHz AES audio via XLR (balanced) connections, and 16-channel embedded
24-bit SDI/HD-SDI audio (capture and playback).

KONA 3 also features high-quality input sample-rate conversion on AES inputs, which
eliminates the need for audio source synchronization.

KONA 3 offers two HD/SD SDI inputs and outputs and a component analog output, each
independently switchable between HD and SD (SD analog can be configured as
composite). For example, if you are working in HD, you can have simultaneous HD-SDI, SD-
SDI, and HD or SD component analog output. Using KONA 3’s always-available format
conversion features, monitoring can be as simple as a single composite monitor for both SD
and HD projects. Dual Link can be monitored via Dual Link HD-SDI outputs, Single Link HD-
SDI, or HD component analog.

When you plug in KONA 3's breakout cables they automatically configure. For SDI video, the
card features two HD/SD inputs and two outputs for Single or Dual Link, one connection for
Genlock input, and three for HD/SD component analog video out. Also included is a 9-pin D
connector for RS-422 machine control. The SDI inputs and outputs use a separate cable with
special mini-BNC connectors on one end and full-size BNCs on the other for ease of
connection and superior reliability.

The K3-Box for KONA 3 simplifies interfacing by offering a 19-inch, 1RU rack-mountable
breakout box that attaches to the KONA 3 with just two cables. This option offers all the
same inputs and outputs as the standard breakout cable, and can be easily rackmounted or
placed on top of a broadcast monitor or editing desk. Additional functionality includes
simultaneous XLR and BNC AES output, 2-channel RCA analog audio monitoring, and
looping BNC Genlock reference connectors. Proper connections are provided for a Betacam
deck, HDCAM, DVCPRO HD, D5, D9, or even HDCAM SR.
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KONA LHi l/O

HD/SD Conversion

Introduction — KONA 3/3x Features

The KONA LHi card provides the Windows workstation with both HD and SD analog and digital
I/0, and HDMI input and output. The LHi SDI 1/0 BNCs also support 3G-SDI, consisting of a single
2.970 Gbit/s serial link, standardized in SMPTE 424M.

KONA LHi Features include:

* 10-bit Uncompressed SD/HD Capture Card

* 12-bit HD Analog Component I/O

* 12-bit SD Analog Component or Composite/YC I/O

* 3G, HD-SDI, or SD-SDI input I/0

* HDMI input and output with v1.3a Deep Color at 30 bits per pixel

* 2-channel balanced XLR AES and 2-channel balanced XLR Analog Audio I/O

¢ 8-channel SDI Embedded Audio I/O

* Broadcast-quality hardware 10-bit up-convert, down-convert and cross-convert.
* Native support for DPX, Cineon, TGA, TIFF, BMP, YUV, AVI and QuickTime files
* HD/SD Genlock

* RS-422 Machine Control

* Cables standard, KLHi-Box breakout box optional

* AJA KONA software, including application plugins and AJA Machina capture/playout
software

* PCl-express (PCle) bus interface

* LTC selectable on reference input

The KONA LHi comes standard with a breakout cable, and also works with the optional KLHi-Box
for rackmounted /0 convenience. It offers multi-channel audio and 16/24/32-bit AES/EBU
digital audio at 48 kHz for digital production. By including hardware sample-rate conversion on
AES inputs, KONA LHi eliminates source synchronizing requirements.

Supporting Digital SD/HD and Analog SD/HD 1/O, KONA LHi fits many diverse workflows
including analog component connections from HDV cameras providing direct ingest of HDV-
acquired material into uncompressed or any other supported file format. These 12-bit analog
inputs and outputs, and 10-bit digital I/0s, ensure that KONA LHi can interface to almost any SDI
or analog device.

KONA LHi is a 4-lane PCl-express bus card that provides HDMI in/out and has 1 SDI/HD input and
1 SDI/HD output. HDMI input and output, effectively allows use of inexpensive but high-quality
HD camcorders for input and HDMI monitors for low-cost HD program monitoring.

KONA LHi also provides 10-bit hardware HD-to-SD up-, down-, or cross-conversion that can be
applied to any or all inputs or outputs. Digitize HD into space-efficient SD for off-line work.
Monitor HD files on an SD monitor. Make analog or digital SD tape masters from an HD project.
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KONA LSe Features

KONA Software

The KONA LS card offers the best solution for affordable SD capture and playback. It offers a
cost-effective solution for capture, playback, and printing video for non-linear editing and
visual effects/motion graphics.

KONA LSe features include:

* 12-bit Component/Composite/S-video analog I/O

* SDlinput and 2 independent SDI outputs

* AES I/0; sample rate conversion on input (2-channel XLR)

* Balanced analog audio I/0O (2-channel XLR)

¢ 8-channel SDI embedded audio support

* Broadcast-quality Time Base Correction (TBC) with VHS support

* Genlock and RS-422 Machine Control

* AJA Support for TGA, TIFF, BMP, AVI, and QuickTime files

* Supports all popular standard definition formats in NTSC and PAL
* Cables standard and KL-Box breakout box optional

* AJA KONA software, including application plugins and AJA Machina capture/playout
software

* PCl-express bus interface (KONA LSe)

The KONA LSe supports TGA, TIFF, BMP, YUV, AVI, or QuickTime.

KONA LSe I/O

KONA LSe can operate with either the standard breakout cable (included) or optional KL-Box
for rackmounted 1/0 convenience. KONA LSe provides high quality analog and digital 10-bit
resolution SMPTE SDI SDI standard definition video connections. KONA LSe also has great
audio I/0O support—2-channel balanced XLR analog, 2-channel XLR AES, and multi-channel
embedded SDI audio. KONA LSe includes hardware sample-rate conversion on AES inputs
eliminating source synchronizing requirements.

KONA software consists of KONA application software (Machina™), KONA driver software, and
KONA plug-in software for 3rd-party applications. This suite of software allows KONA to work
in a variety of workflows. The plug-ins provide tightly integrated KONA source selection and
control within 3rd-party applications. KONA software provides direct support for Adobe
Premiere Pro CS5, Adobe After Effects CS5, Adobe Photoshop CS5, Autodesk Combustion
2008, and Eyeon Fusion 6 (64-bit) (application software not included).

With a Windows workstation, and KONA, you have a high-quality cost-effective system for
standard definition, high definition, digital and analog video production workflows (features
vary with each model). Software is supplied on CD, including:

* AJA’s Machina Capture/Playback application
* Drivers for the card itself

¢ All files necessary for interfacing with third-party software applications
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What’s In The Box?

When you unpack your AJA KONA LSe, LHi or KONA 3, you'll find the following components:

* AJA KONA for PC Software and Documentation CD-ROM - this CD contains the software
installer to place KONA drivers, plugins, and the AJA Machina capture/playback
application on a Windows workstation. The CD also contains a wide variety of useful
information. (A separate CD is provided with Mac OSX Installation software for KONA use
on Macs.)

* The KONA model you ordered
* Cable assembly - the appropriate KONA Standard Breakout cable for your KONA card

* Read Me First Notice — late-breaking news and/or errata related to KONA and the
documentation

* Registration Sheet - register your card by mail or online (details provided)

AJA KONA LS,
LHi or 3x Card
(KONA LHi shown)

Installation Software CD

(1 KONA for PC CD and Installation and Operation Manual
1 KONA for Mac ) in electronic form on the CD (PDF)

Standard Cable

KONA Breakout Cable (LHi/LSe version shown)

KONA Shipping Box Contents

Minimum System Requirements

AJA Video recommends that your system meet minimum hardware and software requirements
to achieve a satisfactory level of performance when operating it. System requirements are
subject to change as new versions of operating systems, QuickTime, and workstations become
available. For the most up-to-date Minimum System Requirements see the AJA website at:

http://www.aja.com/support/kona/kona-system-configuration.php
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Understanding Disk
Storage Methods

Cable Connections

Using the Breakout
Cable and Card
Endplate
Connectors

To ensure performance and quality, the disk storage system used with the Windows
workstation must be able to meet the demands of storing realtime uncompressed media. At
the very minimum, the disk storage system must be able to provide and maintain a consistent
50 MB/s transfer rate from the workstation to disk (read/write). There are a variety of system
configurations and peripherals that can provide this level of performance. Refer to “Computer
Requirements for KONA Cards ” on page 19 for information on testing data rates and storage
performance.

KONA offers unsurpassed cable connectivity for a video/audio capture card. Connections are
made via the supplied breakout cable and connectors mounted on the KONA Card endplate.

The breakout cables for the three KONA models are shown on the following page.

KONA LHi and LSe Connectors
The KONA LHi and LSe models use a breakout cable that supports:
* Reference Input (BNC connector)
* Component/Composite/S Video Input (3x BNC)
* Component/Composite/S Video Output (3x BNC)
* AES In (2x XLR)
* AES Out (2x XLR)
¢ Balanced Audio In (2x XLR)
¢ Balanced Audio Out (2x XLR)
* RS-422 Machine Control (9 pin D)

Connectors on the KONA LHi card endplate additionally provide:

* Standard-definition or High-definition SDI input (1 BNC) and output (1 BNC)
* HDMI input and output (2x HDMI mini-connectors)

KONA LSe Connectors

The KONA LSe model has no endplate BNC’s and uses a breakout cable to provide the same
audio/video and reference I/0 as the LHi and LSe models (supporting standard definition
only).

A 9-pin D connector on the LSe endplate provides RS-422 Machine Control connection.
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KONA 3 Connectors

KONA 3 provides complete I/O connectivity choices in two breakout cables. One cable
provides AES/EBU digital XLR connections and analog video monitoring connections. The
other cable has 4 mini-connectors on one end and 4 BNCs on the other providing SDI
connections for both Single Link and Dual Link SD/HD SDI connections. Cable connections are
marked on both the KONA card endplate and on the cable connectors for easy identification.

KONA 3x D Connector

3 BNCs (Analog Connections):
In SD Can be Configured for
Component,

Composite,

or 5-Video

In HD Can Only Be Component .

KONA 3x Mini-BNCs

Audio Output XLRs i
Channels 1-8 ﬂ.-

Reference Input BNC m@:l—
(2 channels/connector) aﬂ.-

Audio Input XLRs
Channels 1-8
(2 channels/connector)

R5422 Machine Control
to VTR (9-pin)
SDI Outl1/Link A BNC ([

SDI Out2/Link B BNC

SDIIn1/Link A BNC 5Dl cable

SDI In2/Link B BNC

SDI Video
with Embedded
Audio In/Out

KONA 3 Breakout Cable
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Using Breakout The KONA product line offers two optional 19” 1RU rack-mountable breakout boxes that attach

Boxes to the KONA card via cables that connect to the back of the Box. These cables are supplied with
the Box. The breakout boxes offer the same inputs and outputs as the standard breakout cables
and more. Breakout boxes can be easily rackmounted or placed on top of a broadcast monitor
or editing desk.

KONA KL-Box for LSe

The KONA KL-Box is connected via one 60-pin to 60-pin, and one 3-BNC to 3-BNC cable. When
you purchase the KL-Box, you get two-channel unbalanced audio output (2 RCA Jacks) not
available with the standard cable. When ordering a KL-Box, specify the KONA card model you'll
be using the KL box with to ensure you get the proper cable set.

Serial RS422
Dllgltal Composite/ !\éachm?
Balanced Audio In AES/EBU Audio " Component ontro
Channels 1 &2 In and Out i Video In

Balanced Audio Out
Channels 1 &2 Serial  External

Analog Audio
Digital  Reference Output
Out  (loop)
Composite/
Component
Video Out

KL-Box Model Breakout Box

KONA KLHi-Box for LHi Cards

The KONA KLHi-Box offers the same connections as the KL-Box except a single connector is
provided for the following: SDI input, SDI output, HDMI v1.3a input, and HDMI v1.3a output.

Note: The HDMI connectors on the breakout box are full-size, not mini as on the LHi endplate.

Balanced Audio In AES/EBU Audio Composite/Component
Channels 1 &2 Inand Out HDMIv1.3a SDI VideoIn RS422

In In Machine Control

Balanced Audio Out HDMIv1.3a Sl External  Composite/ Analog
Channels 1 &2 Out Out Ref.or LTC Component Audio
(loop) Video Out Output

KLHi-Box Model Breakout Box
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AES/EBU Audio In
Channels 1 through 8 Channels 1 through 8 Channels 1 through 8

K3-Box for KONA 3

The K3-Box for KONA 3 offers convenient connector access and additional functionality
including simultaneous XLR and BNC AES output, 2-channel RCA analog audio monitoring,
and looping BNC Genlock reference connectors. If you're using a digital Betacam deck,
HDCAM, DVCPRO HD, D5, D9 or even an HDCAM SR, you'll have the proper connections.

Serial RS422
Digital Machine
AES/EBU Audio Out AES/EBU Audio In In Control

AES/EBU Audio Out ‘
Channels 1 through 8 Serial  External Component/ Analog Audio

Digital Reference  Composite Output
| oOut (loop) Video Output

Connector
Descriptions—
LSe/LHi Cables and
KL-Box

All AES/EBU audio connectors have two channels
per connector

K3-Box Model Breakout Box

Connectors on the standard cable set are labelled by their function for easy installation and
maintenance. Connectors on the optional KL-Box are similarly labelled.

SDI Input and Outputs

BNC connectors are provided on the KONA LHi card endplates for one SD-SDI or HD-SDI input
and one SDI output (format independent of the input). The SDI input and output support
video and embedded 24-bit digital audio. Use SDI wherever possible for the best quality 10-
bit uncompressed video input, capture and output. If peripheral equipment has a variety of
inputs/outputs, look to see if it has SDI I/0, and use it where possible. Most high-end
professional broadcast equipment supports SDI (VTRs, cameras, media storage servers, etc.).

HDMI Input and Output

Two HDMI mini-connectors on the LHi endplate (full-size HDMI connectors on the KLHi Box)
provide for input and output of HDMI compatible video (version 1.1) and multi-channel
embedded audio (8 channels). HDCP is not supported on either input or output. The LHi’s
HDMI output does not have HDCP, and input sources having HDCP are not supported. The
HDMI input is designed to support long cable runs—up to 100 ft when using 22 or 24AWG
HDMI cable, or up to 50 ft using 28 or 30AWG HDMI cable. The HDMI output supports
standard HDMI cables only.

2-Channel Digital AES/EBU Audio Inputs And Outputs

One female XLR connector is provided for the channel 1 and 2 inputs, while a male XLR
connector carries channel 1 and 2 outputs. AES/EBU signals are handled internally as 24-bit
digital.The optional KL-Box also provides XLR audio connections on the front panel.

Note: AES XLR connections are digital and cannot be used with analog equipment having
XLR connectors.
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Analog 2-Channel Balanced Audio

Two sets of analog XLR connectors, one for each channel, support balanced audio connections.
Male XLRs are provided for outputs and female XLRs are provided for inputs. Balanced audio
(differential) connections provide better analog audio quality over longer cable runs. Most
professional quality VTRs and audio equipment have XLR style connectors for analog audio.
Analog audio signals are converted internally to 24-bit digital.

Analog 2-Channel Unbalanced Audio (KL-Box only)

On the KL-Box are two analog output connectors, one for each channel. These connectors are
RCA-style phono jacks.

RS-422 Machine Control

A female DE-9 connector on the LHi/LSe breakout cable provides connection for VTRs,
camcorders, disk media servers, and other devices using RS-422 SMPTE (Sony) protocol. This RS-
422 connector is also present on the optional KL-Box (connector pinout is listed in “Machine
Control Connector Pinout” on page 118).

Connector Connectors on the standard cable set are labelled for their function for easy installation and
Descriptions— maintenance. Connectors on the optional K3-Box (breakout box) are similarly labelled.
KONA 3 Cables and

K3-Box 8-Channel Digital AES/EBU Audio Inputs and Outputs

When using the standard cables, XLR connections are provided for AES/EBU audio input/output.
Four female XLR connectors are provided for audio input and four for audio output. Each XLR
carries two channels. XLR connectors are labeled for input/output and channels.

The optional K3-Box provides both BNC and XLR audio connections on the front panel.

Note: XLR connections are digital and cannot be used with analog equipment having XLR
connectors.

Analog 2-Channel Unbalanced Audio (breakout box only)

On the breakout box are two analog output connectors, one for each channel. These connectors
are RCA-style phono jacks.

RS-422 Machine Control

A female DE-9 connector provides connection for VTRs, camcorders, disk media servers, and
other devices using RS-422 SMPTE (Sony) protocol. This connector is present on both the
general I/O cables and the optional K3-Box. (Connector pinout is listed in “Machine Control
Connector Pinout” on page 118.)

SDI Inputs and Outputs

On the KONA 3/3x card, mini-connectors are provided for two SDI inputs and two SDI outputs
for Single or Dual Link. A cable with four Mini-connectors on one end and four BNCs on the
other end is provided for connecting equipment to the SDI inputs and outputs.

KONA 3 has three video outputs altogether—two SDI outputs that are used for both High- and
Standard-definition (SD/HD-SDI), and one component analog output (discussed later). Each of
the three outputs is independently switchable between HD and SD. For example, if you are
working in HD, you can have simultaneous HD-SDI, SD-SDI, and HD-component analog output.

SDlinputs and outputs support video and 8-channel embedded 24-bit digital audio. Use SDI
wherever possible for the best quality 10-bit uncompressed video input, capture, and output. If
peripheral equipment has a variety of inputs/outputs, look to see if it has SDI 1/0, and use it
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wherever possible. Most high-end professional broadcast equipment supports SDI (VTRs,
cameras, media storage servers, etc.).

Analog Monitor Out (Component/Composite HD/SD)

Both the standard I/0 cable and the optional KL-Box feature two groups of three BNC
connectors each, for input and output of component, composite and Y/C functions. The
signals are labelled on both the cable and KL-Box connectors.

The analog component output can be switched between SD and HD. KONA 3 features 12-bit
component video output for both HD and SD. SD can be switched to composite and Y/C. (The
same three BNC connectors share component and Y/C functions.) This allows use of an
inexpensive analog monitor for both HD and SD work. You can even use a composite video
monitor. For Dual Link HD-SDI output, HD or SD can be monitored through the component
output. Dual Link HD can be output as 4:4:4 RGB.

Component video signals are generally higher quality than composite, but not as high-quality
as serial digital (SDI).

Note: About RGB: Although RGB is used less in today’s video systems, KONA 3 supports it for
A/V Monitor output. However, because the KONA 3 (and SMPTE SDI’s) native format is
YPbPr, AJA recommends using YPbPr when the monitor supports it. The YPbPr format
provides “headroom” for “superwhite” and superblack”—and these video levels will be
clipped when transcoding to RGB. Also, the RGB/YPbPr transcoding involves a level
translation that results in mathematical round-off error. RGB can be configured in the
Playout setup panel of the specific application you are using with KONA 3.

Note: About YPbPr: KONA 3 supports three different types of YPbPr:

* SMPTE/EBU N10
e Betacam (NTSC)
* Betacam (NTSC-J [Japan]).

These three formats differ in level only and can be configured in the Playout setup panel of
the specific application you are using with KONA 3.

Reference Video

A single BNC on the standard KONA cable—or two BNC connectors on the K3-Box (it loops
through)—allow you to synchronize KONA outputs to your house analog reference video
signal (or black burst). If you have a sync generator or central piece of video equipment to use
for synchronizing other video equipment in your studio, connect its analog composite output
here. When KONA outputs video, it locks to this reference signal. When connecting a reference
video source, the locking signal should be the same format as the Primary format selected in
KONA software. It is possible in some circumstances to use an alternate format video signal if
the basic frame rate is compatible.



Introduction — Cable Connections

In This Manual

This manual is written for the KONA for PC software. The AJA Windows plug-ins information is
shown throughout the manual using example Windows 7 screens and discussion. This text also
applies to AJA Mac Plug-ins for Adobe which run under OSX Snow Leopard (the screens and
functions are mostly identical). For both Windows 7 and Snow Leopard platforms, use this
manual for understanding AJA’s Plug-ins for Adobe CS5.

Chapter 1 is the introduction you're reading, listing features, box contents, system requirements,
and connection hardware.

Chapter 2 provides complete instructions for installing the AJA KONA card. The user is guided
through unpacking, installing the card into a Windows workstation, installing KONA Software
From CD, cabling the system and getting it up and running. Important configuration
information is also provided on video settings and use of genlock/external reference.

Chapter 3 discusses KONA features that are common across all its plug-ins and the KONA
Machina application. Here you'll find a basic overview of how KONA operates and is configured,
from making source and format selections to capturing, previewing, and playing back video and
audio.

Chapter 4 discusses operational aspects of KONA when used with AJA’s Machina capture/
playback application.

Chapter 5 discusses operational aspects of KONA when used with Adobe Premiere Pro CS5
editing and motion graphics software.

Chapter 6 discusses operational aspects of KONA when used with Adobe After Effects CS5
compositing software.

Chapter 7 discusses operational aspects of KONA when used with Adobe Adobe Photoshop CS5
photo/graphics editing application.

Chapter 8 discusses operational aspects of KONA when used with Autodesk Combustion 2008
software (PC only).

Chapter 9 discusses operational aspects of KONA when used with Eyeon Fusion v6.0 (64-bit)
software (PC only).

Chapter 10 discusses other third-party applications that provide native support for KONA cards
(PC).

Chapter 11 discusses troubleshooting problems with your system and what to do when there’s a
problem you can't solve. It also provides a list of Frequently Asked Questions (FAQs).

Appendix A contains the technical specifications for the product.
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Chapter 2: Installation & Hardware Configuration

Installation Overview

The installation and set up of a KONA with a PC is very simple. All of the steps of installation
and hardware configuration are described in this chapter and are summarized as follows:

1.
2.

Unpack the shipping box

If not previously installed on your PC, ensure that your editing or capture/playback
applications are installed as detailed in their user documentation. These applications
must be installed and have been run at least once prior to installing AJA KONA
software to allow proper interface setup.

Configure your Workstation as appropriate for your workflow requirements. A URL to
AJA Support is provided for getting the latest tested and approved KONA and RAID
storage configurations.

Install the latest AJA KONA software on your Workstation.

Cable the system audio and video sources, VTR, audio monitor, and video monitor. If
you purchased the optional KL-Box or K3-Box, install it in an equipment rack or place it

on a desk and connect its two cables to the KONA card. If you are using the standard
cable set instead, connect those directly to the equipment.

These steps are explained in greater detail in the following pages.
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Unpacking
Shipping Box Your KONA card is shipped with a breakout cable and two CDs: one KONA for PC and one
Contents KONA for Mac. Each CD contains software and an Installation and Operation manual (a

PDF on the CD) for that platform. If you purchased the optional KL-Box or K3-Box breakout
box, it ships with its own set of cables and instructions for connection to the KONA card.

Y il

AJA KONA LS,
LHi or 3x Card
(KONA LHi shown)

Installation Software CDs

Installation and Operation Manual
in electronic form on the CD (PDF)

Standard Cable

KONA Breakout Cable (LHi/LSe version shown)

Contents, KONA Shipping Box

As you unpack the shipping box(es), carefully examine the contents. Ensure you received
everything and nothing was damaged in shipment. If you find any damage, immediately
notify the shipping service and supply them with a complete description of the damage
then contact your AJA dealer or distributor for details on how to have your KONA repaired
or replaced. AJA will repair or replace damaged items.

Save packing materials and the shipping box. If you ever require service or move your
system—use the packaging materials and box for safe shipment.
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Computer Requirements for KONA Cards

For the most up-to-date computer system requirements for KONA, consult the AJA

website:
http://www.aja.com/support/kona/kona-system-configuration.php
AJA Data Rate AJA offers a Data Rate Calculator utility for KONA users as a resource for configuring
Calculator systems and determining storage requirements. This application calculates data rates and
. . storage requirements for a given video size, format, and frame rate and is available for
Appllcatlon for download at:
Windows
http://www.aja.com/support/kona/kona-3-3x.php
(See Utilities and Optional ajashare at the bottom of the webpage.)
Note: Note: It is the storage vendor’s responsibility to maintain sustained playback.
Many benchmark utilities show a speed test in an ideal setting but will not sustain
that data rate for sequential data reads/writes as required in a true video editing
environment. Use the calculator to determine the data rate required and then
proceed to the system test described below.
AJA KONA System KONA System Test is available on the AJA website at:
Test

http://www.aja.com/support/kona/kona-3-3x.php

(See Utilities and Optional ajashare at the bottom of the webpage.) KONA System Test
is a Windows utility for measuring system performance with AJA KONA Video Capture
cards. The application includes disk drive speed tests and video data copy (DMA) speeds.
The disk speed tests differ from standard disk I/O performance applications in that they
specifically test the system under conditions typically encountered with video capture,
playback, and editing.

Note: Note: Most of the disk performance tests are generic and don’t require an AJA
KONA Video Capture card. The DMA performance tests do require a KONA card and
AJA KONA Driver software to operate.

We suggest the best test is to fill your storage disk to 80% and then test capture at the
highest data rate you will use. Use Machina Capture Status display to monitor lost frames
(“Capture Controls” on page 53).

Installing the KONA Card

1. Place the PCin a well-lit convenient area, where you will have easy access to the
chassis access door.

2. Touch the outside of the PC to discharge any static electricity in your body.
Remove the power cable from the back of the PC.

3. Open the PC to gain access to the card slots as described in your Workstation User
Manual.

4, Remove the KONA card from its protective anti-static bag; place the card on top of
the bag.

5. Toinstall the KONA card and RAID controller card (SCSI or Fibre Channel), refer to
the AJA website for the latest installation updates at:

http://www.aja.com/support/kona/kona-system-configuration.php

Because of hardware and software changes, AJA engineers are constantly testing and
grading workstation performance. The AJA website is your best source of up-to-date
approved workstation configurations.
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Note: Always put the RAID controller and KONA on separate PCl busses. This improves

performance by reducing bus contention.
5 I CPUO
|

1B PCI32/33 | ]

2 I [PCLEGXT |

KONA LSe, LHi, or 3
l ) i g P
KONA LS or 3x \ Claz3 L]
4
5 BB PCIX 641133 ]

\ CPU 1

¢ I PCIX64100 | ]
SCsi2 SCSI1
7 I PCEX 641100 | | m 7 1 = |

KONA Card placement in HP XW8200 Motherboard

6. Open the card retainer bar on the left side of the chassis cardcage. Remove the card
edge access cover from the desired slot where you will be inserting the KONA card.

7. Holding the KONA card by the card edge plate and an outside edge, carefully insert
the KONA card by rocking it slowly into the slot. Ensure the card edge aligns properly
with the PC’s opening (where the card edge cover was just removed) and that it is
fully seated in the slot.

8. Secure the card in the slot replacing the card retainer bar.
9. Replace the PC’s panel/door removed in step 3.

[T T TS

i)

i,

Card edge
covers

Locate the correct PCl Slot and Insert the KONA Card (typical installation shown)
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Cabling KONA
Make video and audio input/output connections according to your workflow requirements.
Each connector is described in detail in Chapter 1. In this section, KONA cable connections are
shown and described for KONA 3/3x, LHi/LSe and KONA LS breakout cables.
Using The 3/3x
Breakout Cable
KONA
Installs in
PCI Slot
in PC
Video Monitor
Component Video
\ AJAKONA3Card |
! (installed in '
i _ the Workstation) !
esssss 3 BNCs (Analog Connections): 1 _ _); :
"'_ In SD Can be Configured for | HDD_ i
Component, ! 1
Composite, : m:'_ '
or S-Video | !

In HD Can Only Be Component

Optional -

G ck

- T ‘

Reference Input BNC

i

Audio Output XLRs
Channels 1-8 H.-
(2 channels/connector) Elﬂ“
Elul 1
' ED:,_ 4-mini BNCs
AESJ’EB_U Audio Out . to 4 standard
to Monitor System Audio Input XLRs m BNCs
Channels 1-8
(2 channels/connector) EED_
rosz2 (H—
Machine Control -
(9-pin) sbi outt/Link ABNG [{{[ T
sDI outziLink B BNC ([{{[ [T
S s ¥ spi IntiLink ABNC [{{( [T SDI cable

SDI In2/Link B BNC [ T
Digital VTR with SDI Inputs

SDI Video
with Embedded
— Audio In/Out
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Dual-link Connections

Using the KONA 3 card, you can take advantage of the speed and quality of Dual-link SDI I/0.
When connecting for dual-link, use the normally separate inputs and outputs numbered 1 &2
as A and B components of the dual-link (thus the connectors are labeled 1A/2B). When
configuring KONA Capture plugins, you will select Dual-link for your SDI input and output

modes.

Using The LHi/LSe
Breakout Cable

Standard Breakout Cable

Reference/LTC m:_
Input BNC

60-pin connector
To KONA LHi or LSe

LSe SDI Input BNC -
SDI Qutput 1 BNC =
SDI Output 2 BNC =

Digital Video/Audio
Connectors

Analog Video

green
——17) ) v/cvesinBNC

Balanced Audio
Analog Audio y
Channel 1 Input
Analog Audio M.
[
Channel 2 Input a -
Analog Audio

Channel 1 Output

Analog Audio Eﬂ:_

Channel 2 Output

AES Input b
Channels 1 &2

blue
1) )¥) Po/vinBNC
red
———11) )} PrcinBNC
green
——— 1) JJF) Y/G/cvBs out BNC

blue

—(11) )JJF)) Pb/B/¥ OutBNC
red
———11) ]F) Pr/R/coutBNC

6 BNCs (Analog Connections):
Can be Configured for
Component,

Composite,

orY/C

RS422
Machine Control

to VTR
(9-pin)

AES Output E(:D_
Channels 1 &2

—_—

KONA
Installs in
PCI Slot
in PC

LHi

Digital Video/Audio =
Connectors |:
(=

Mini HDMI
Input (1) and Ouput (1)  e—)
SDI Input BNC s [}
SDI Output BNC s ]
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Using The LS
Breakout Cable

KONA LS
Installs in

PCI Slot
inPC

Standard Breakout Cable 44-pin connector
To KONA LS

i

I:[IIIIIII[I I:IIIIIIIIII]]
RS422

Machine Control
to VTR

Reference Input BNC m{:]_ (user-supplied 9-pin cable)
SDI Input BNC ['(l.ll- green

SDI Output 1 BNC ([ [T piue
Pb/Y In BNC
sl output 2 BNC [{{[ (13 )

e 11) )J¥) Prc inBNC

green
Y/G/CVBS Out BNC

Y/CVBS In BNC

:

é

Balan Audii
alanced Audio blue

Analog Audio aﬂ.- -lll}si] Pb/B/Y Out BNC
red '
CnsnneRiinpit 11] )J¥) prric outBNC
Analog Audio .
Channel 2 Input 6 BNCs (Analog Connections):

Can be Configured for
Analog Audio ED:_ Component,
Channel 1 Qutput Composite,
Analog Audio E(:D_ orY/IC
Channel 2 Output
AES Input
Channels 1 & 2
AES Output E:D_
Channels 1 & 2
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A Typical System The following figure shows a typical system interconnections for a system with digital A/V
sources using the KL-Box for KONA LS or LHi cards. Your system may differ depending on VTRs,
audio monitoring, and video monitoring.

Analog Audio
Inputs/Outputs
(Balanced)

| to Monitor System d
Machine
| | | | | | Control

\
Jﬁnn.n.n.n.n.n.n. 1 Connect to

! 1 KL-Box Using

1 Cables and Instructions

. If desired, connect your house reference sync to the KONA Ref Loop connector (BNC).

The second KONA Ref Loop connector on the KL-Box (if used) can be connected to the
VTR or terminated with a 75-ohm terminator.

. Connect a Video Monitor to the KONA Component Analog Video Out BNC connectors

(preferred), or connect to a composite monitor.

. Connect a 9-pin DE-9 machine control cable between your VTR’s RS422 control port

and the KONA breakout cable RS-422 machine control connector.

. Connect two SDI cables between KONA (BNCs are on the card endplate) and your

digital VTR (Digital Betacam etc.): one from KONA SDI In to the VTR SDI Out, and one
from KONA SDI Out to the VTR SDI In.

The KONA SDI connections have embedded audio so the VTR must be configured
accordingly.

. If you have an AES/EBU-ready audio monitoring system, connect the two channels of

AES/EBU output from KONA's XLR connectors (channels 1 and 2) to the monitoring
system AES/EBU inputs. If instead you have an analog audio monitoring system, you
can use either the XLR balanced audio connectors or the two RCA-style unbalanced
stereo output jacks on the Optional KL-Box for output.

Digital VTR with SDI Inputs

Audio Monitor —

= |
f= =\ . -
I .
) 1 :
|| - -

Reference Monitors SDI Video

AES/EBU Audio In/Out Audio In/Out

with Embedded
I RS422

¢ Supplied With it

L]
1
T_:f Installed 1
l—I—E Inside PC !

Videa Monitor
Component
Video

External Reference

Computer Monitor

o g

AJA KONA Card

=

1
Raid driver card : external
1

t====r

Installed in the PC RAID

Typical System Connections—Shown with Optional KL-Box
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Genlock and Your System

For video stability and proper system operation, it’s always best to genlock all equipment to
house sync. Although genlock is not absolutely required for KONA or your system, you will have
better quality and repeatable operation using it. Usually, this means using a black burst
generator output looped through the system. On the KONA cables and optional

KL-Box, KLHi-Box, and K3-Box breakout boxes, house sync is connected to “Ref Loop”

Note: If you are using the KONA LHi, be sure to set the Reference/LTC connection to Reference
in the Machina Control Panel (Windows).

Installing KONA Software

If your PC has previously had another video capture or multimedia card installed, remove the
card and uninstall any related software before installing KONA. Also, always uninstall existing
KONA software before installing a new version. This will prevent hardware/software conflicts.

Note: Before proceeding, ensure that your capture Application software (Adobe or other) is
installed as detailed in its user documentation. These applications should be installed and
run at least once prior to installing AJA KONA software.

Download the latest KONA software from the AJA website or, if that is not possible, use the CD-
ROM supplied with the KONA system to install necessary software drivers and AJA's Machina
Capture/Playback application (if desired). System software updates occasionally become
available to AJA KONA owners on our website at:

http://www.aja.com/support/index.php

We recommend checking for both software updates and additional product information before
installation and periodically thereafter.

The installation procedure is described below. You cannot use KONA with third-party
applications until the AJA KONA software has been installed on the host workstation.

If you add KONA supported applications at a later date and have not previously installed the
appropriate plugins, you must run the install program again selecting the appropriate
application support software to be installed.

Software Locate the AJA KONA Software download or CD ROM packaged with your system and follow
Installation the procedure below to install the required software on the host system. The KONA for PC
Procedure software is intended for Windows 7 64-bit workstations.

Note: Before installing KONA software, turn off any virus protection and security software that
you have installed on your computer.

Double click on the download package or insert the KONA CD into the PC.

Install Wizard

The KONA installation program will launch and extract the necessary KONA drivers and KONA
Control Panel software for installation on the desired hard drive.
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# AJA Windows Software 5.0.0 Setu

A A Welcome to the AJA Windows Software
] -+ 5.0.05etup Wizard

VIDED SYSTEMS

The Setup Wizard will install AJA Windows Software
5.0.0 on your computer, Click Mext to continue
or Cancel to exit the Setup Wizard.

Install Wizard Welcome

When you see the Welcome page, click “Next” to view the KONA license agreement.

5 AJA Windows Software 5.0.0 Setu

End-User License Agreement
Flease read the following license agreement carefully

LAJA WVideo Systems EKONA Software License -
IMPCRTANT: THIS SOFTWARE LICENSE AGREEMENT LJ
("LICENSE™) IS5 &L LEGAL AGREEMENT BETWEEN YOU (EITHER
AN INDIVIDUAL CR, IF PURCHASED CR CTHERWISE ACQUIRED
BEY CR FOR AN ENTITY, AN ENIITY) AND AJA WIDEOC
SYSTEMS. READ IT CAREFULLY BEFORE COMPLETING THE
INSTALLATION PROCESS AND USING THE SCOFIWARE. IT
PROWVIDES & LICENSE TO USE THE SOFTWARE AND CONTATINS
WARRANTY INFORMATICH AND LIABILITY DISCLAIMERS. BY
INSTALLING AND USING THE SCOFIWARE, YOU ARE

[¥]1 accept the terms in the License Agreement

Back [ omext [ Cancel

License Agreement

Read the KONA license agreement and click “Yes” to accept. You will be asked to choose the
type of installation you would like to perform.
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4 AJA Windows Software 5.0.0 Setu

Choose Setup Type
Chooze the setup type that best suits your needs

Allows users to choose which program features wil be installed and where
they will be installed. Recommended for advanced users.

All program features wil be installed. Requires the most disk space.

Back E Mext i [ Cancel

Installation Type

If you don't have all the KONA supported products installed on your workstation, you may
choose to perform a Custom installation (default) and select only the software necessary for
your applications. Otherwise, use the “Typical” installation. The following screens depict the
more elaborate Custom installation.

4 AJA Windows Software 5.0.0 Setu

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

This is the device driver for the

- Adobe Photoshop Plug-in board. Be sure to use the correct
. Adobe After Effects Plug-in driver for the card you have
: Autodesk Combustion Plug-in installed.
’ AJA QuickTime 7.0 Codecs This feature requires OKE on your
: eyeon Digital Fusion Plug-in hard drive. Ithas 3 of 3
<= = | Adobe Premiere Pro Flug-n subfeatures selected. The

b =+ | AVI Video For Windows subfeatures require 40KE on your

hard drive.

Custom Installation Menu
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You may deselect any Item for installation by using the pulldown to make it unavailable.

.
4 AJA Windows Software 5.0.0 Setu

Custom Setup
Select the way you want features to be installed.

This is the device driver for the
Will be installed on local hard drive orrect

=
=38 Entire feature will be installed on local hard drive

g Em Wil be installed to run from network N your
B Em B Entire feature will be installed to run from network
[ . . . N your
= Feature will be installed when required
4 [
¥ Entire feature will be unavailable

FOWSE, ..

( Reset I Disk Usage |[ Back || mext || cancel

Custom Selections Pulldown Menu

Use the second level options choose the specific drivers and plugins you would like installed.

v
5 AJA Windows Software 5.0.0 Setu

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

EIQI AJA Drivers & The device driver for the Kona 3,
b | = - | [ERERIIRINEISINEE || Kona LHi or IoExpress device. Be

| =2 Will be installed on local hard drive

. =B Entire feature will be installed on local hard drive

(=0 Feature will be installed when required

¥ Entire feature will be unavailable

Lk - |

Browse. ..

” Cancel

Custom Selection Second-level Options
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Disabled selections are marked with a red X. Before clicking Next to install, you can verify your
disk space availability by clicking the Disk Usage button.

4 AJA Windows Software 5.0.0 Setu

Disk Space Reguirements
The disk space required for the installation of the sel . &

Highlighted volumes do not have enough disk space available for selected features. You
can either remove some files from the highlighted volumes, install fewer features, or select
different destination drives.

Volume Disk Size Available Required
156GE 293MB

Workstation Disk Usage Display

To return to the installation click OK. Click Next to begin the installation. screen.

) AJA Windows Software 5.0.0 Setu

Ready to install AJA Windows Software

Click Install to begin the installation. Clidk Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

[ Back H '@'Insiﬁll ] [ Cancel

Begin Driver and Plugin Installation
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Re-Installation &
Repair

When the installer has completed copying the KONA software to disk, you may see a standard
Windows Logo test warning. Click on the “Continue Anyway” button to finish the installation.

When the installation is completed, a final screen will be displayed announcing that “Setup
has finished installing AJA KONA on your computer.” Click on the Finish button after the
installation is complete. Restart the computer after installation to activate the KONA card.

You must restart your system for the configuration
changes made to AJA Windows Software

5.0.0 to take effect. Click Yes to restart
now or Mo if you plan to manually restart later.

Restart Screen

If you have problems running your newly installed pluggins or need to re-install for added
applications, you can relaunch the install package and access the following window.

Note: Note: Always uninstall KONA software before installing a new version.

-
5] AJA Windows Software 5.0.0 Setug

Change, repair, or remove installation
Select the operation you wish to perform.

Change i
Lets you change the way features are installed.

Repairs errors in the most recent installation by fixing missing and corrupt
files, shortcuts, and registry entries.

Remove

Removes AJA Windows Software 4.2, 1-x64 from your computer,

Change, Repair, or Remove Installation Menu



Chapter 3: Setup & Configuration

Setup Overview

This Chapter discusses the KONA features that are common across all its plug-ins and the
Machina application. Here you'll find a basic overview of how KONA operates and is
configured, from making source and format selections to capturing, previewing, and playing
back video and audio.

Selection of Primary & Secondary Formats

In KONA's operation, the Primary Format is that which is written to disk. The Secondary Format
is set to match the format of the input device (if the Primary Format is a conversion) or to
match the format that is set for an output monitor if you'’re monitoring a conversion and the
Primary Format is the format on the input device.

Note: The KONA Secondary Format nomenclature places (O) or (I) at the end of the signal
format: (O) indicates the selected secondary format is for output only. (I) indicates the
format selection is that of an input only.

The Secondary Format isn't used if there are no conversions. In all of the applications
supported by KONA, you can set these formats. In the Adobe applications (Premiere Pro, After
Effects, and Photoshop), the KONA plug-ins provide similar ways of making these choices. In
each application, though their interfaces may differ, these choices are virtually the same. .

The Primary Format menu allows you to select the video format to be used in the current
project. Analog output is always available and performs a conversion, if necessary, based on
the Primary or Secondary Format.

Note: No frame rate interpolation is applied for conversions from one frame rate to another.
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Primary and

Secondary Format Video Signal Formats KONA LSe KONA LHi KONA 3

Options Supported 720x576 @ 25.00i Yes Yes Yes

by KONA cards 720x576 (Wide) @ 25.00i Yes Yes Yes
720x486 @ 29.97i Yes Yes Yes
720x486 (Wide) @ 29.97i Yes Yes Yes
720x480 @ 29.97i Yes Yes Yes
720x480 (Wide) @ 29.97i Yes Yes Yes
1280x720 @ 23.976p Yes Yes
1280x720 @24.00p Yes Yes
1280x720 @ 25.00p Yes Yes
1280x720 @ 29.97p Yes Yes
1280x720 @ 30.00p Yes Yes
1280x720 @ 50.00p Yes Yes
1280x720 @ 59.94p Yes Yes
1280x720 @ 60.00p Yes Yes
1920x1080 @ 23.976sF Yes Yes
1920x1080 @ 24.00sF Yes Yes
1920x1080 @ 25.00sF Yes Yes
1920x1080 @ 29.97sF Yes Yes
1920x1080 @ 30.00sF Yes Yes
1920x1080 @ 25.00i Yes Yes
1920x1080 @ 29.97i Yes Yes
1920x1080 @ 30.00i Yes Yes
1920x1080 @ 23.976p Yes Yes
1920x1080 @ 24.00p Yes Yes
1920x1080 @ 25.00p Yes Yes
1920x1080 @ 29.97p Yes Yes
1920x1080 @ 30.00p Yes Yes
1920x1080 @ 50.00p Yes Yes
1920x1080 @ 59.94p Yes Yes
1920x1080 @ 60.00p Yes Yes
2048x1080@23.976sF Yes
2048x1080@24.00sF Yes
2048x1080@23.976p Yes
2048x1080@24.00p Yes
2048x1556@14.98p Yes
2048x1556@15.00p Yes

Primary to Secondary conversion allows you to set up down-, up-, and cross-conversion
depending on the KONA model and formats supported.



Convert Mode

Setup & Configuration — Convert Mode

Allows selection of a conversion mode for up-, down-, or cross-conversion between High-
definition and Standard-definition, or High-definition to High-definition formats. The
choices offered depend on the KONA model present and the Primary and Secondary
format chosen. KONA 3 and LHi models support up-, down-, and cross-conversion plus
SD-to-SD aspect ratio conversions. The LS model (SD only) has no conversion.

KONA LHi & KONA 3 Conversion Options:

Primary Video Format

Secondary Format Options

720x480 @ 29.97i 1920x1080 @ 29.97i
720x480 (Wide) @ 29.97i 1280x720 @ 59.94p
720x486 @ 29.97i 720x486 @ 29.97i
720x486 (Wide) @ 29.97i
720x576 @ 25.00i 1920x1080 @ 25.00i
720x576 (Wide) @ 25.00i 1280x720 @ 50.00p
720x576 @ 25.00i
1280x720 @ 23.976p 720x486 @ 29.97i
1920x1080 @ 29.97i
1280x720 @24.00p 1920x1080 @ 30.00i
1280x720 @ 25.00p 720x576 @ 25.00i
1920x1080 @ 25.00i
1280x720 @ 29.97p 720x486 @ 29.97i
1920x1080 @ 29.97i
1280x720 @ 30.00i 1920x1080 @ 30.00i
1280x720 @ 50.00p 720x576 @ 25.00i
1920x1080 @ 25.00i
1280x720 @ 59.94p 720x486 @ 29.97i
1920x1080 @ 29.97i
1280x720 @ 60.00p 1920x1080 @ 30.00i
1920x1080 @ 23.976sF 720x486 @ 29.97i
1920x1080 @ 24.00sF None Available
1920x1080 @ 25.00sF 720x576 @ 25.00i
1280x720 @ 50.00p
1920x1080 @ 29.97sF 720x486 @ 29.97i
1280x720 @ 59.94p
1920x1080 @ 30.00sF 1280x720 @ 60.00p
1920x1080 @ 25.00i 720x576 @ 25.00i
1280x720 @ 50.00p
1920x1080 @ 29.97i 720x486 @ 29.97i
1280x720 @ 59.94p
1920x1080 @ 30.00i 1280x720 @ 60.00p

All conversions use AJA 10-bit hardware on the card.
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To do a down-conversion on an HD input (KONA 3 and LHi models):

* Set the Primary Format as an SD format

* Select the correct HD format with an (l) input designation for the Secondary Format,
then

* Choose a “- Secondary” Video Input type

To do an up-conversion on an SD project for HD output (KONA 3 and LHi):

* Set the Primary Format as an SD format

* Select the correct HD format with an (O) output designation for the Secondary Format,
then

* Choose a “— Secondary” SDI1/2 Output type and an HD Analog Output

Down-conversion display mode choices that may be available include (KONA 3 and LHi):

* Anamorphic: full-screen

* Letterbox: image is reduced with black top and bottom added to image area with the
aspect ratio preserved

* Crop: image is cropped horizontally to fit new screen size

Up-conversion display mode choices that may be available include (KONA 3 and LHi):

* Anamorphic: full-screen
* Pillarbox 4x3

* Zoom 14x9

* Zoom Letterbox

* Zoom Wide

For Cross-conversion (KONA 3 models):

¢ Set the Primary Format as an HD format (what you want the input converted to)

* Select the correct input HD format with an () input designation for the Secondary
Format

KONA 3 cross-conversion allows you to convert from one format of HD to another, such as
1080i @ 29.97 to 720p @ 59.94. KONA 3 does not perform 2K to HD cross-convert, but can
display a cropped cut of the 2K on an HD monitor. In addition to HD-to-HD cross-
conversion, KONA 3 also can perform SD to SD hardware based aspect-ratio conversion for
capture and output. This is controlled the same as all other up/down/cross-conversions. Use
it by selecting a ‘Secondary Video Format’ that matches the ‘Primary Video Format’ and
then specifying the conversion using the ‘Convert Mode’ control.
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KONA Format Setup Options

Video Input

Each KONA plug-in, and the stand-alone Machina application, offer a Video Input pull-down
menu to select an appropriate signal type for your input. (The current selection is reported in
the display of the pull-down menu.)

Video Input always shows all the available input options based on your Primary and Secondary
format configuration. KONA software looks at 1) what model you have, 2) Primary Format, and 3)
Secondary Format (in that order) to determine the appropriate input options.

Video Input Options Supported by KONA cards include:

¢ Single Link SDI * Component Betacam NTSC-J
* Composite NTSC * Component SMPTE NTSC-J
¢ S-Video NTSC * Composite PAL
* Component Betacam NTSC * S-Video PAL
* Component SMPTE NTSC * Component Betacam PAL
* Composite NTSC-J * Component SMPTE PAL
¢ S-Video NTSC-J * Component XVGA (HD only)
¢ Dual Link HD (KONA 3 only) * HSDL (KONA 3 only)
Audio Input

Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The
current selection is reported in the Status Display.)

Audio Input Options Supported by KONA cards include:

* Embedded SDI
* Digital AES/EBU - XLR
* Digital AES/EBU - BNC (only applies if you are using a KL- or K3-Box)

SDI Outputs 1 & 2

When using KONA LS and LHi cards, the SDI outputs will be Single Link only, if there is no
Secondary Video Output Format selected. If you have a Secondary format selected, you can
choose between Single Link SDI - Primary and Single Link SDI - Secondary as your output.
KONA 3 also offers Dual Link output which uses both output connectors for a single A/B
channeled output (SDI Output 2 automatically becomes Dual Link).

On KONA LHji, there is only one SDI output, but there is an HDMI output. You can independently
configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E).

Analog Output

Analog format choices in the Analog Output pull-down menu vary depending upon file format.

* Composite + S-Video NTSC

* Composite + S-Video NTSC-J
* Component Betacam NTSC
* Component Betacam NTSC-J
* Component SMPTE

* Component XVGA (HD only)

* Composite PAL

* S-Video PAL

* Component Betacam PAL
* Component SMPTE PAL

* Component RGB
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Note: When SD and HD formats are available as Primary and Secondary formats, you can
choose between SD and HD raster for the Analog Output.

Audio Level
Choose between +6 dB (US) monitor level and +0 dB (EBU).

Timecode Input

Select the type of timecode used by the source video machine—RS-422, Embedded SDI
(RP188) or choose to input an External LTC timecode source input via the KONA RS-422 port.

Note: SMPTE RP 188 defines a standard for the transmission of time code and control code in
the ancillary data space of a digital television data stream. Time code information is
transmitted in the ancillary data space as defined in ANSI/SMPTE 291 M. Multiple codes
can be transmitted within a single digital video data stream. Other time information, such
as realtime clock, DTTR tape timer information, and other user-defined information, may
also be carried in the ancillary time code packet instead of time code. The actual
information transmitted through the interface is identified by the coding of a distributed
binary bit. EQuipment manufacturers can use the meta data for different purposes.

Desktop Display Options
Select one of four modes of desktop display:
* Off
* Display while idle only (this mode is suggested)
* Display during capture only
* Display Always

Display to Desktop uses system resources and could affect performance. Choose Capture
Speed, Width, and Height as appropriate for your system capabilities.

Desktop Speed:

¢ Full Speed - Every frame is displayed to desktop during playback
* Half Speed - Every other frame is displayed to desktop during playback
* Quarter Speed - one out of every four frames is displayed to the desktop

Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is
using to draw video to your computer.

Desktop Capture Width and Height: These selections allow you to reduce the
resolution of the desktop capture display. The captured file will be full-resolution. Only the
displayed image is reduced to save processing resources during capture. The choices
available are:

¢ Full Resolution * Eighth Resolution
* Half Resolution * Sixteenth Resolution

¢ Quarter Resolution
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File Options
KONA supports the following Video and Audio Formats:

Video Formats:
* 8-bit YUV 4:2:2 - “2vuy’
* 8-bit YUV 4:2:2 - ‘2Vuy’
* 10-bit YUV 4:2:2 - 'v210’
* 8-bit RGB 4:4:4 - 'rgb’
* 8-bit RGB 4:4:4 - ‘bgr’
* 8-bit RGBA 4:4:4:4 - "argb’

* 8-bit RGBA 4:4:4:4 - ‘rgba’

* 8-bit RGBA 4:4:4:4 - ‘bgra’

* 10-bit Log RGB 4:4:4 - ‘R10g’
* 10-bit RGB 4:4:4 - ‘R10k’

* 10-bit RGB 4:4:4 - 'r10k’

Audio Formats (96 kHz available on KONA 3 only):

* 48 kHz 16-bit PCM Mono
* 48 kHz 24-bit PCM Mono
* 48 kHz 32-bit PCM Mono
* 96 kHz 16-bit PCM Mono
* 96 kHz 24-bit PCM Mono
* 96 kHz 32-bit PCM Mono

* 48 kHz 16-bit PCM Stereo
* 48 kHz 24-bit PCM Stereo
* 48 kHz 32-bit PCM Stereo
* 96 kHz 16-bit PCM Stereo
* 96 kHz 24-bit PCM Stereo
* 96 kHz 32-bit PCM Stereo

KONA 3 supports up to 16 channels of audio (eight stereo pairs), while the other KONA cards
support up to eight (four stereo pairs). Adobe Premiere Pro CS5 supports six channels.

Capture, Preview, and Playback—Differences and Similarities

The services that KONA provides differs based on the plug-ins. Some applications, like Adobe
Premiere when used with its KONA plug-in, offer full support for media capture, previewing from
RAM, and playback to monitors and to an attached VTR with full machine control. Other
applications and their KONA plug-ins offer different levels of support. This section describes the
support provided by each KONA plug-in and the Machina standalone application and discusses
what each of these capabilities mean.

Capture Overview Capture records the source signal to your storage system from the chosen input connector(s),
digitizing and encoding the media (audio and video) to disk as you've directed in your KONA
configuration settings. Media may be recorded directly as configured as the Primary Format
(framebuffer) or with some type of conversion performed—a Secondary Format at the input (set
up in KONA configuration) is converted to the Primary Format (as allowed by the KONA model you

have).

For those applications that do not directly support capture via KONA, you can always use Machina
to perform the capture and then load the media into the desired application as a QuickTime, AVI,
or still image file.

Preview Overview Preview is the viewing of captured media from RAM memory in the computer. It is not necessarily
realtime since it’s affected by CPU performance and other real world factors such as other
activities that might be occuring on the host computer. RAM preview occurs on the computer
monitor. The purpose of preview operations is to review the captured material and perform

editing/trimming operations.

Playback Overview Playback differs from Preview in that the media is read directly from disk storage and output, as
configured, to KONA outputs. Playback also outputs machine control signals to the R5422
connector directing VTR operations. Playback is frame-accurate and suitable for broadcast and

print-to-tape.
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Support for The following table shows for each of the KONA for PC plug-ins and the Machina application,
Capture, Preview which Capture, Preview, and Playback services are provided.
and Playback

Application or Plug-in Capture Y/N | Preview Y/N | Playback Y/N | Notes

Machina Y Y Y Use tabbed windows to configure

Adobe Premiere Plug-in Y Y Y Capture & Preview: file-> capture
Playback: project->"project settings”
->General->"playback settings” button

Adobe After Effects CS5 Y Y Y AJA plug-in screen available under
Plug-in Windows menu

Adobe Photoshop CS5 Y Y N Capture 1 frame: file->Import->
Plug-in “AJA image capture”

Combustion Plug-in N Y N Preview: file->preferences->host->

framebuffer->framebuffer type->
AJA Preview->click “Options”

Eyeon Fusion Plug-in N Y N Preview: file->preferences->
“global and new comp defaults”->
preview->options->

"display file sequences on” ->

AJA Preview

To Edit AJA Settings:
file->preferences->

“global and new comp defaults”->
I/O -> AJA Preview
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Codex Utility

When KONA software is installed, a utility application named Codex is put in the AJA directory
(Programs -> AJA -> Codex). This utility allows you to make global adjustments to the YUV/RGB
Matrix in both the QuickTime and AVI Codecs used by third-party applications. (Does NOT apply
to Premiere Pro CS5 and After Effects CS5.)

The Codex utility allows you to adjust the matrices used when YUV-RGB conversions are
performed by applications such as Fusion, and Combustion. These conversions occur during
YUV-RGB encoding/decoding when creating or opening QuickTime and AV files using the AJA
AVI/QuickTime codecs.

AJA Codex

AVl Decompress Matrix CuickTime Decompress Matrix

5D YUV Matrix SD YUV Matrix
601 CGR 601 CGR

HD YUV Matrix HD YUV Matrix
709 CGR 709 CGR

AVl Compress Matrix QuickTime Compress Matrix

5D YUV Matrix SD YUV Matrix
601 CGR 601 CGR

+* Allow Super Black v Allow Super Black
+* Allow Super White v Allow Super White

HD YUV Matrix HD YUV Matrix
709 CGR 709 CGR

+ Allow Super Black + Allow Super Black

+ Allow Super White +" Allow Super White

Apply Reset

Codex Application Screen

The pulldown menus in this screen are organized by the function being performed. Pulldowns
on the left are for AVI file decompression and compression and those on the right are for
QuickTime decompression and compression.

In each pulldown, the current setting is displayed. When you click on any of the pulldowns, the
choices available for each are all the same:

* 601 SMPTE
* 601 CGR
* 709 SMPTE
* 709 CGR

The 601 matrices govern Standard-definition component digital color scaling matrices and the
709 apply to High-definition color scaling matrices.



ALA

VIDED SYSTEMS

If you make a change to the existing setting it will only be saved and used when the Apply
button at the bottom of the Codex screen is clicked.

Clicking the Reset button, located next to the Apply button, restores the factory default
settings.

Note: Similar controls can be found in the KONA plugins for Adobe Premiere Pro CS5 and
Adobe After Effects CS5 rather than in the Codex application.

KONA DVCProHD Support

KONA Capture

AJA’s Hardware
Scaling Support

Codec
Requirements

AJA includes a DVCProHD codec for capture and editing with the KONA card. The KONA
installer includes Adobe Premiere Pro project presets specifically for use with DVCProHD
compressed files. These project presets have raster sizes that match the non-standard
resolutions and pixel aspect ratios of DVCProHD. They are especially useful when the bulk of
the project media will be DVCProHD.

DVCProHD compressed Quicktime files can be captured from HD-SDI or analog sources using
either AJA's Machina, or Adobe Premiere Pro CS5 (see Capture setup instructions for the
specific application). All normal capture instructions apply except for the following:

* “File Type” must be Quicktime

* “Video Subtype” must be DVCProHD

* “Primary Video Format” should be set to the real HD raster size

For example, if capturing from a 1920x1080 source, that same raster should be selected in the
“Primary Video Format” control in the capture settings. The encoder will automatically scale
the video down to the appropriate DVCProHD resolution. When using KONA DVCProHD
project presets, these settings will already be preset.

Once capture is completed a Quicktime file will exist on the specified hard disk. If capturing in
Adobe Premiere Pro, the Quicktime file will automatically be imported into the current
Premiere project bin.

For more information on using DVCProHD for:

* Compressed Online Editing,

* Compressed Offline Editing,

* Import, Editing, and Playing Multiple Media Types,

* Cross-Platform Workflow with KONA and DVCProHD
see the whitepaper DVCProHD Editing with KONA at

http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf

Most AJA hardware has built in hardware-based scaling support that allows for DVCProHD
resolution up-sampling and down-sampling to be done in real-time, with very high quality.
This hardware-based scaling is done during capture and during playback or output from the
editing timeline. The KONA LHi and the KONA 3 both have this support built in.

The DVCProHD support included with KONA for PC requires the presence of the KONA card,
and works only in the applications using the card. Quicktime files captured with KONA can be
used in other applications, and even on other platforms, but they require the presence of a
third party DVCProHD Quicktime codec like the one included in Final Cut Pro, or the
standalone Quicktime decoder by Calibrated Software (www.calibratedsoftware.com).
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Machina Capture/Playback Application

KONA Realtime
Performance

Machina (pronounced: mock’-en-uh) is AJA’s powerful standalone capture/playback
application that includes full VTR machine control. It is an easy-to-use interface that provides
access to any and all KONA supported file formats, video standards, and video conversions.
Captured files can be imported into virtually any software package that supports these file
formats—such as 3D animation programs, audio editing programs, and more. With Machina,
you can also accurately output files exported from these same programs to tape.

The Machina application is part of the software package that came with your KONA card. If
you haven't already done so, launch the KONA Install CD, follow the prompts, and click on the
Machina short-cut placed on the desktop to launch Machina.

This chapter addresses configuration and setup unique to use of KONA LSe/LS, LHi, and 3/3x
models with Machina.

With KONA LS running Machina, in realtime you can:

1. Capture uncompressed analog or digital SD, component/composite, or S-Video to: Tiff,
Targa, Bitmap, Quicktime, AVI, or YUV

2. Playback to two displays simultaneously, SD-SDI and analog
3. Import or Export: Tiff, Targa, Bitmap, Quicktime, AVI, or YUV
With KONA LHi running Machina, in realtime you can:

1. Capture uncompressed analog or digital SD and HD, component/composite, or S-
Video to: DPX, Cineon, Tiff, Targa, Bitmap, Quicktime, AVI, or YUV
2. Down-convert from HD to SD during capture or playback
3. Playback to two displays simultaneously, SD-SDI and analog
With KONA 3 or 3x running Machina, in realtime you can:
1. Capture Uncompressed digital SD or HD via SDI or Dual Link to: DPX, Cineon, Tiff, Targa,
Bitmap, Quicktime, AVI, or YUV

2. Up-convert SD to HD, Cross-convert 1080i <-> 720p, and Down-convert SD to HD
during capture or playback

3. Display to three monitors with various conversions

Note: AJA KONA now includes a codec for capture and editing compressed DVCProHD. See
“KONA DVCProHD Support” on page 40
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Machina Overview

Activation Options

AJA’'s Machina provides three tabbed windows that perform the following:

* Setup - set Activation, Capture, Playback, Device Control, and General options
* Capture - set Capture file and Clip options and Control the capture

* Play - set Playback file options and Control the playback
AJA Machina

Setup

Board
Board: 1 Type: Kona 3

Activation Mode

Auto

Kona Status

Active

Kona License
Standard

Kona Serial Number

WO0B20487
Machina Version

Shortcuts and

4.21.0

Display Features

Play Options Device Control Options General Options
Primary Video Format

1920x1080 @ 29.97i v

Timecode Format Video Directory
Base 24 c:

Secondary Video Format
None ¥

Timecode Source Audio Directory
LTC c:\

Audio Sync

Primary Enforce Memory Alignment

Preroll (Seconds)

Convert Mode

None Enable Audio Scrubbing

Enable Audio VariSpeed
+ Enable Audio Auto-Search

Handles (Frames)

YUV=<->RGB Range

CGR TC Offset(l) (Frames)

Audio Monitor Levels
Gain @ 6 dB

Audio Sample Rate
48kHz

SDI1 Output
Single Link SDI

SDI2 Output
Single Link SDI

TC Offset(O) (Frames)

Analog Output
Component SMPTE

Reference
Free Run

H Reference Offset

V Reference Offset

Machina Application Interface - Setup Menu

This section of the manual will discuss each of these windows in detail and discuss how
various Pull-down menu options, hot-text entry fields, and play/record controls function
and interact.

Note: The specific options available to you are determined by the currently active AJA
capture device model installed in your workstation. This section will describe all
possible options for Machina and note any options exclusive to KONA.

Keyboard Shortcuts

Space Bar - Use it to start and stop playback of media. Pressing the Space Bar starts
playback from the location of the Edit Line.

| key — press to set an In-point when trimming a clip.

J key - press to shuttle backward through the clip. Press repeatedly to move at a faster rate
(2x, 4x, etc.).

K key — press to stop playback at the current position.
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L key - press to shuttle forward through the clip. Press repeatedly to move at a faster rate (2x, 4x,
etc.).
O key - press to set an Out-point when trimming a clip in Machina.
Left Arrow key (<-) — press to move one frame backward.
Right Arrow key (->) — press to move one frame forward.
Up Arrow key — press to start playback (forward).

Down Arrow key — press to start playback backward.

Full-screen Desktop To use Machina for full-screen preview during capture or playback, first maximize the Machina

Display window, then hit the Escape key. This can be especially useful for monitoring capture or
playback in the absence of a full-resolution monitor. In full-screen mode you can use the mouse
to control picture position and zoom for detail monitoring of graphic elements or frame-cut
results (see “Display Sizes” on page 52 in this section).

Setup Window

To configure the Machina operation, click on the Setup tab at the top of the window. In the left-
most column are the Activation Options. The next column will toggle between Capture and
Playback options when you click on the arrow tabs to the left and right of the header text. Next,
Device Options address machine control settings. Finally, General Options establish paths to file
storage directories for Video and Audio files and enable other options.

Activation Options

Activation Options

Board
Board
Note: The term Board in this case refers to the AJA capture ltetiel ) Uil laie e
device being controlled by an application. In this section Activation Mode
you will find the terms “board,” “card;’ or “capture device” RV
used interchangeably. Kona Status
Active
The Board window/menu reports the current Type of AJA
capture device (lo Express or KONA card) selected. Kona License
Standard
Note: Using multiple AJA capture devices in the same Kona Serial Number
workstation is possible but not always practical due to WoB20487

Machina Version

motherboard and disk system bandwidth limitations. 4210

Activation Mode

Machina and KONA plugins in Adobe applications can be set for Automatic or Manual activation
using the Activation Mode pull-down menu. Automatic is the default setting and is
recommended for normal operation. Current activation status is reported below the pull-down
menu.

The KONA card can be accessed by multiple application client windows but only one can have
control at a time (for example, Adobe Premiere Pro and Adobe Photoshop). In automatic mode,
an application or plugin can take active control when the KONA card is not being used. When
the controlling application is done (and any processing initiated is complete), control is
released, making the KONA card available to others.
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Note: If the application window you click on does not access KONA (reporting KONA Status:
Active), either another application window is still processing operations or it is set in
Manual activation mode. (Remember: only one client window can have control of the
KONA card at a time.) If it is controlled by an application in Manual mode, you must either
un-check the enable check-box or select Auto in the Activation Mode pull-down menu to
relinquish control.

In Manual mode, you must click on the enable check-box to activate board-control.

KONA Information

At the bottom of the Machina Setup screen, in the left hand column, you'll find vital
information about your specific KONA card —license type, serial number, and version. This
information will be helpful if you ever need technical support.

To the right of “Activation Options “there is a column
that can toggle to either “Capture Options” or “Play
Options.” The arrow buttons on either side of the
Capture Options/Play Options button determine which
of the two is displayed. Under Capture Options, you can
select the appropriate formats and settings for your
project.

Capture Options

Primary Video Format
1920x1080 @ 29.971 ~

Secondary Video Format
The Primary Format menu allows you to select the video None v
format used in your current project. The Secondary
Video Format allows KONA to perform up-, down-, and
cross-conversion of input or output video (as supported

by your KONA model).

Convert Mode
None

YUV=->RGB Range

. . CGR
Analog output is always available. =

Video Input
Primary and Secondary Video Options Sup- s
ported by KONA

See “Selection of Primary & Secondary Formats ” on
page 31 for Primary/Secondary video format and
conversion information.

Audio Input
Embedded SDI

SDI1 Output
Single Link SDI

HDMI Output

Note: No frame rate interpolation is applied for B

conversions from one frame rate to another.
Analog Output

Throughout Machi na, choices are always presented Component SMPTE

based on which KONA card you are using and what it
can do with the signals available and the inputs/
outputs selected. For example, the LHi and KONA 3
cards offer up-, down-, and cross-conversion for
supported formats. KONA LS is standard definition only
and does no coversion.

Timecode Input
RS422

YUV<->RGB Range

This control mode should almost never be changed from its CGR default. This setting is only
for highly-knowledgeable users that must define how color values will be mapped when
doing the color space conversion—far less than 1% of all users should ever need to use it. Use
this feature only for capturing YUV source into an RGB file, or to play an RGB file out to YUV.
The CGR setting maps the typical YUV values to typical RGB values. For example, 8bit YUV 16
is mapped to 8 bit RGB 0, and YUV 235 to RGB 255. The ‘SMPTE' setting for this control maps
YUV into RGB using the exact YUV values. Therefore, 8 bit YUV 16 will map to RGB 16, and so
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forth. Only change this setting from its default if you are absolutely sure you know the benefits/
consequences. This feature is not the same as a broadcast safe limiter.

Video Input

Use the Video Input pull-down menu to select the appropriate signal type of your input. (The
current selection is reported in the display of the pull-down menu.)

Video Input always shows all the available input options based on your Primary and Secondary
format configuration. KONA software looks at 1) what model you have, 2) Primary Format, and 3)
Secondary Format (in that order) to determine what input options are appropriate.

Video Input Options supported by KONA cards include:

¢ Single Link SDI * Component Betacam NTSC-J
* Composite NTSC * Component SMPTE NTSC-J
* S-Video NTSC * Composite PAL
* Component Betacam NTSC * S-Video PAL
* Component SMPTE NTSC * Component Betacam PAL
* Composite NTSC-J * Component SMPTE PAL
¢ S-Video NTSC-J * Component XVGA (HD only)
* Dual Link 4:4:4 HD-SDI (KONA 3 only) * HSDL (KONA 3 only)
Audio Input

Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The
current selection is reported in the Status Display.)

Audio Input Options Supported by KONA cards include:
* Embedded SDI
* Digital AES/EBU - XLR (using either breakout cable or breakout box)

* Digital AES/EBU - BNC (only applies if you are using a breakout box with BNC connectors
for AES/EBU)

* Analog (except for KONA 3/3x)

Note: On the KONA 3, you can choose between 48 kHz AES/EBU (for standard audio) and 96
kHz AES/EBU (for extra-high quality audio).

SDI Outputs 1 & 2

The SDI outputs will be Single Link, Dual Link (available with KONA 3 card only), or Video+Key
(also only available with KONA 3 card). If you have assigned a Secondary Video Format, you can
select either the Primary or Secondary format for the SDI Output:

¢ Single Link SDI - Primary
* Single Link SDI - Secondary
* Dual Link SDI - Primary (KONA 3 model only)
* Dual Link SDI - Secondary (KONA 3 model only)
On KONA LHi, there is only one SDI output, but there is an HDMI output. You can independently

configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E).

On KONA 3, the two SDI outputs can also be configured to output a Video signal on one SDI
output and a Key video signal on the second SDI output for use with external devices that
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support separate video and key (switchers, DVEs, etc.). This feature is also available on the
output settings in After Effects CS5, and Photoshop CS5. To configure separate video and key,
set the SDI-1 Output to ‘Video + Key (V)' or ‘Video + Key (K)' The SDI-2 output will then
automatically change to the complimentary setting. Video + Key is limited to 8 bit RGBA files.

Analog Output

Analog format choices in the Analog Output pull-down menu vary with selected file format.

Analog Output Options Supported by KONA cards include:

e Composite + S-Video NTSC * Composite PAL

* Composite + S-Video NTSC-J * S-Video PAL

* Component Betacam NTSC * Component Betacam PAL
* Component Betacam NTSC-J * Component SMPTE PAL

* Component SMPTE * Component RGB

* Component XVGA (HD only)

Timecode Input

Select the type of timecode used by the source video machine — RS-422, Embedded SDI
(RP188) or choose to input an External LTC timecode source input via the KONA RS-422 port.

Timecode Input
RS422
RS422

Embedded LTC (RP188)
Embedded VITC #1 (RP188)
Embedded VITC #2 (RP188)
External LTC Port

Note: SMPTE RP 188 defines a standard for the transmission of timecode and control code in
the ancillary data space of a digital television data stream. Timecode information is
transmitted in the ancillary data space as defined in ANSI/SMPTE 291 M. Multiple codes
can be transmitted within a single digital video data stream. Other time information, such
as real time clock, DTTR tape timer information, and other user-defined information, may
also be carried in the ancillary timecode packet instead of timecode. The actual
information transmitted through the interface is identified by the coding of a distributed
binary bit. EQuipment manufacturers can use the meta data for different purposes. After
configuring Machina Capture Options, select the Play options by clicking on the toggle
arrows on either side of the Capture Options title header.

Primary Format, and Output Type settings are all the same for playback mode as those
described previously. Refer to “Capture Options” on page 44.

Audio Sync

Choose to sync audio output to either the Primary Format or the Secondary format if it is
available. When a Primary/Secondary conversion is done, there may be a 0.5 or 1 frame delay
introduced. Audio Sync will ensure that either the Primary or Secondary format is kept in sync.

Audio Sample Rate

Choose either 48 kHz or, if you are using extra high-quality audio, KONA 3/3x supports 96
kHz.
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Timebase

Use the Timebase pull-down menu to choose between:
* Frames
* Timecode (NDF)
¢ Timecode (DF)

* Reference

Using the Reference pull-down menu, select timing Reference source — Free Run, from External
(genlock), or from the video Input signal.

Device Control Device Control Options set options for the RS-422 machine control interface on the KONA card.
Options These functions support Print-to-Tape machine control.

Device Control Options

Timecode Format
Base 30 DF

Timecode Source
LTC

Preroll (in Seconds)

Handles (in Frames)

TC Offset{l) (in Frames)

TC Offset{O) (in Frames)

Machina Device Control Options

Timecode Format
Use this pull-down to select the timecode base supported by your VTR.
* Base 24
* Base 25
* Base 25 (50 frames per second)
* Base 30 DF (drop-frame, 30 frames per second)
* Base 30 NDF (non-drop-frame, 30 frames per second)
* Base 30 DF (drop-frame, 60 frames per second)

* Base 30 NDF (non-drop-frame, 60 frames per second)
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Timecode Source

Choose between a separate-channel Longitudinal Timecode (LTC) or Vertical Interval
Timecode (VITC) transported in the video signal’s vertical interval or include both (LTC + VITC).

Click on the Hot Text items to enter a value for:

* Preroll - 0 to 15; the number of frames required to start the source machine before
capture

* Handles - 0 to 60; the number of frames added to the front and back of a sequence for
editing flexibility

* Timecode Offset— -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and that of the
captured sequence.

Video/Audio Directory Setup
Use these hot text fields to enter the path of the default

capture/playback directories. General Options

. Video Directory
Enforce Memory Alignment R:\VideoTestiPubTest
For almost all cases this checkbox should remain

. Audio Directory
unchecked. However on certain types of RAID Controllers R:\AudioTest

(usually RAID5 SATA), when reading or writing to disc,

to or from system memory, memory alignment must be
done on a 512-byte address alignment. Enabling this
option insures that reading/writing is done to a 512-byte
address in system memory. But there is a performance +/ Enable Audio Scrubbing
cost. Due to re-alignment, reading/writing is not +/ Enable Audio VariSpeed
guaranteed to be in realtime. +/ Enable Audio Auto-Search

Enforce Memory Alignment

. . Audio Monitor Levels
Audio Files Setup None

Three audio enable check boxes, when checked, allow you
to:

* Enable Audio Scrubbing — Audio will play while you move through frames using the
scrub bar (see Play Controls).

* Enable Audio Variable Speed - Audio will play at the same speed the video is played
(rather than 1x only).

* Enable Audio Auto-Search - KONA software will automatically load the Audio Track list
with audio files that have been generated with the same name as the selected video file.

Note: When Audio Auto-Search is active, existing file names in the list will be removed or
over-written when the Video File is loaded. (Does not affect the actual audio files.)

Audio Monitor Levels
Choose between +6 dB (US) monitor level and +0 dB (EBU).
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Capture Window

Click on the Capture tab to bring up the Capture window. The figure below shows the Clip
Options panel. Also available by clicking on the hot toggle buttons left and right of the title
header are File Options and Display Options and Overlay Options.

AJA Machina

Clip Options

Clip Name
Salling 2007
Reel Name
Scofts Flat

Sequence Offset

+ Create New Folder Per Seq

Abort on Dropped Frames

Capture Now Capture Status

Idle

(0)
(0}

I«

Offline 00:00:00:00

Machina Capture Window
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File Options In the File Options menu you will configure the capture file
you will be creating by setting the following. Fils Options
File Type
Type QuickTime Movie
The Type pull-down menu provides a choice of video/audio V‘j"i““f‘:“"i?
file formats: a0 = ANCe

Video Subtype

Note: Because the KONA LS is a YUV only device, file types AJA DVCProHD
that require RGB colorspace cannot be used.

* QuickTime Movie Audio Subtype
48kHz 16-bit PCM Mono ¥

* TGA Sequence )
Audio Tracks

* AVI Movie 1 v

* BMP Sequence

* DPX Sequence (KONA 3 & LHi only)

* TIF Sequence

¢ Cineon (KONA 3 & LHi only)

* YUV Sequence

Video/Audio
Use this pull-down menu to select the video/audio input combination you will capture:
* Video Only
¢ Audio Only
* Video - (minus) Audio - video and audio are recorded in separate files
¢ Video + (plus) Audio (QuickTime only) - video and audio are recorded in the same file

The options shown are determined by the selected file format. QuickTime captured audio is
either embedded with the video file or captured to separate .mov files. All other formats
capture audio to Wave Files.

Video Subtype
Video Capture Formats supported by KONA cards (varying according to file type) include:
* 8-bit YUV 4:2:2 - "2vuy’ * 8-bit RGBA 4:4:4:4 - ‘rgba’
* 8-bit YUV 4:2:2 - "2Vuy’ * 8-bit RGBA 4:4:4:4 — 'bgra’
* 10-bit YUV 4:2:2 - ‘'v210' * 10-bit Log RGB 4:4:4 - ‘R10g’
* 8-bit RGB 4:4:4 - ‘rgb’ * 10-bit RGB 4:4:4 - 'R10k’
* 8-bit RGB 4:4:4 - 'bgr’ * 10-bit RGB 4:4:4 - 'r10k’

* 8-bit RGBA 4:4:4:4 - ‘argb’

Audio Subtype

Audio Capture Formats supported by KONA cards include:.
* 48 kHz 16-bit PCM Mono * 48 kHz 16-bit PCM Stereo
* 48 kHz 24-bit PCM Mono * 48 kHz 24-bit PCM Stereo
* 48 kHz 32-bit PCM Mono * 48 kHz 32-bit PCM Stereo

KONA 3/3x also supports 96 kHz 16 through 32-bit PCM Mono and Stereo selections
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Audio Track

Select the number of audio tracks for this project. KONA models support up to 16 tracks
depending on the Model.

Clip Options Clip Name

In the Clip Options menu, click on the Clip Name to name the
file you will be creating. Subsequent file numbers will Clip Options
increment from this one.

Clip Name

Salling 2007

Reel Name Reel Name

Click on the hot text field to enter a source tape name—the
name of the tape on the VTR. Only QuickTime and DPX files Sequence Offset

store this information.

Sequence o ffset + Create New Folder Per Seq
When capturing file-per-frame sequences, after naming a file, Abort on Dropped Frames
you can set a Sequence Offset number that will determine
the beginning number of the file sequence.

Create New Folder Per Sequence

A check-box is provided to enable this automatic function. When you check this selection,
Machina will gather each frame capture sequence in a new folder, based on clip names, on your
disk. (Not applicable to QuickTime or AVI movie files.)

Abort on Dropped Frames

Checking this box causes a capture to automatically stop any time that KONA detects frames are
being dropped for some reason. This ensures you don’t waste storage space and time capturing
when there may be a problem with the capture.

Display Options Display Options configure how the desktop display operates for capture.
Display Type
The Display Type pull-down menu provides a choice of display Diapiny Opfions
rendering formats: OpenGL Texture or OpenGL DrawPixels. This Display Type
setting changes the way the PC’s GPU handles video overlay on OpenGL DrawPixels
your desktop monitor. OpenGL Texture should always be used Display To Desktop
whenever possible. Note, however that this setting is not While Idie Only
guaranteed to work on all boards. It has been tested primarily Display Size
with high-end nVidia workstation graphics cards. Using OpenGL 100 Percent
Texture mode will allow any applied LUTs to be displayed on the
desktop display as well as on the video output. Display Size

Open GL DrawPixels should only be used when you are
experiencing display problems. Typically, this will be for
graphics cards that are not AJA approved, and that have less
OpenGL support. This mode does not allow applied LUTs to be
displayed on the desktop. This mode also has many limitations
when working with YUV files. When using this setting, files may appear pixelated on the desktop
display. This does not affect the quality or resolution of the video being captured or output from
the KONA card.

Display X Origin

Display ¥ Origin
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Display To Desktop

This setting determines when the desktop monitor overlay is present. Choice include:

* OFF - always off (no display)

* While Idle Only - displays whatever is present at the selected input while idle; when
capturing, there is no display (saving system resources)

* While Capture Only - only display while capturing

* Always - display during capture and when idle

Display Sizes

The desktop monitor display will be sized according to this setting. You can choose from
select sizes (25% to 800%), enter a custom size (Custom), or have KONA fit the display size
according to your Machina screen (Fit). If you use Custom, use the hot text fields underneath
Display Sizes to enter a specific percentage and X and Y origin points.

You can also zoom picture size by clicking on the Size hot text field and dragging to the left or
right. Zoom can also be done using the scroll-wheel of your mouse (especially helpful when
viewing the display in Full-screen mode, see “Shortcuts and Display Features” on page 42). To
move the picture within the display, just click in the display area and drag the picture.

The final options selection in the Capture window is Overlay Options. These overlay controls
allow you to insert a graphic file supporting alpha channel transparency to apply an effect or

insert a bug (logo) over the video content.

Enable Overlay
Enable/disable the overlay using this checkbox.

Mixer Coefficient

Adjust the overlay file transparency (range: 0 to 1000).
Double-click on the field to select and enter a value or
click-drag left or right to increment or decrement
(respectively).

Foreground Video
Select the blending mode for the foreground layer:

* Full Image
¢ Pre-Mult Alpha
* UnShaped

Background Video
Select the blending mode of the background layer.

GraphicFile

- Overiay Options

+" Enable Overlay

1000 Mixer Coefficient

Foreground Video
UnShaped

Background Video
Full Image

Graphic File
T istrator\DesktopiUntitled-1.tga

Use as Background Video

Click in the text entry field to browse for the overlay file you want to use. Click on the trash can

to the left to delete the current selection.
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Use as Background Video

Check this box to place the Graphic File on the Background layer and place the motion video in
the foreground layer.

Capture Controls Standard tape deck icons provide hot buttons for the Capture process. They are:

44 Rewind (8x) B Fast Forward (8x)
4 Reverse Play M Reverse 1 frame
sl B Stop
®  Play (1x) M Forward 1 frame

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x.

The red button is for Record.

Capture Mode | | Capture Time Entry Fields | | KONA Status

Capture In/Out { 00;00;00;00 00;00;00;00 } 00;00;00;01 Kona Status

Active
> pp 1920x1080 @ 29.97i
Single Link SDI 1
Embedded SDI

Offline 00:00:00:00

| VTRSstatus

Machina Capture Controls

The toggle buttons on the top-left step through one of three capture modes:

* Capture Now — manual record/stop (“crash”) capture
p p p

* Capture Duration - capture a specified number of frames after manual start, based on the
timebase of the selected Primary Format

* Capture In/Out - initiate and end capture using timecode-based in and out settings

The selected mode will activate the appropriate hot text for that mode (to the right of the
Capture Mode selection). Click the hot text to enter a timecode value
(hours:minutes:seconds:frames). The bottom display indicates the current machine status and
timecode from the VTR.
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Capture In/Out Mode

The capture in-point is entered by clicking on the left field of eight digits. The out-point can
be set by clicking on the right field of eight digits. Alternatively, you can specify a duration in
the Duration field and the in- or out-point (whichever you have not entered) will be entered
automatically according to duration.

Note: The in-point/out-point field values are inclusive. If both are set to the same value, the
capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the hot
text field and enter from your keyboard.

Note: When a hot text field has a dotted underline, you can left-click and hold on the field
and drag your curser to increment or decrement the value.

VTRTC

The current VTR timecode is displayed on the bottom of the control pane and you can click on
it and enter a timecode to perform a seek to that timecode on the VTR. The VTR must be
online and in remote rather than local control mode (as reported to the left of the current
timecode).

Capture/KONA Status

Click on the hot toggle buttons of the Status header to switch between Capture Status and
KONA Status. Capture Status reports current state of activity, capture duration and number of
frames captured in (), and the number of frames that may have been dropped.

KONA Status reports Active/Inactive status, Primary Format setting, Video Input type, and
Audio Input type.
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Play Window

AJA Machina

File Options

Video
T TestVidi2x testisailing 02.mov

8-bit YUV 4:2:2 - "2Vuy'
5861 Frames

Look Up Table
[Empty]

Audio
[Empty]
[Empty]
[Empty]
[Empty]
[Empty]
[Empty]
[Empty]
[Empty]

E} E} E} E} £} E} E} Ef

Kona Status

Active
1920x1080 @ 29.97i
Single Link SDI
Single Link SDI
Component SMPTE

Machina Play Screen

File Options On the right side of the desktop display, you can use the hot buttons at the top to toggle
between File Options, Display Options, and Leader/Trailer Options. In File Options, the current
file name and path is loaded into the Video field. Alternatively, you can click on the path hot text
to select a file, delete it using the trash icon at the left, or turn it on/off using the check-box at
the right.

Format, Colorspace, and total number of frames in the file is reported below the path text.

You can preview the effects of a color Look Up Table by clicking on the LUT hot text or delete the
selected LUT file by clicking on the trash icon.

You can edit the Audio Track list that is automatically loaded with audio files that have been
generated with the same name as the selected video file. QuickTime embedded audio files are
automatically appended with a number and will be loaded numerically into the track list. Click
on the trash icon to delete a track. Click on the check-box on the right to enable/disable a track.
To manually enter audio files, simply double-click on a track in the list.
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In the Display Options menu you will configure how the desktop display operates during
playback operations.

Display Type

The Display Type pull-down menu provides a choice of display rendering formats: OpenGL
Texture or OpenGL DrawPixels. This setting changes the way the PC’s GPU handles video
overlay on your desktop monitor. OpenGL Texture should be used whenever possible. These
options were described in detail earlier under the Capture screen options.

Display To Desktop
This setting determines when the desktop monitor overlay is present. Choice include:
* OFF - always off (no display during scrubbing or playback)

* While Scrubbing Only - displays media as you scrub through it via the playhead; during
playback there is no display (saving system resources)

* While Playing Only - displays media only during playback

* Always - display during playback and when idle

Display Sizes

The desktop monitor display will be sized according to this setting. You can choose from
select sizes (25% to 800%), enter a custom size (“Custom”), or have KONA fit the display size
according to your Machina screen (“Fit"). If “Custom” is chosen, use the hot text fields
underneath Display Sizes to enter a specific percentage and/or X and Y origin.

Leader/Trailer Options allow you to add colorbars, test tone, and black field in a leader to your
clip and black field as trailer. Note that the dotted underline indicates that you can left-click
down and scroll the mouse to increment/decrement these values.

4 LeaderTrailer Options »

Leader

Leader/Trailer Options
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Play Controls There are two modes of play control—one for Edit and one for Output. Click the hot buttons at
the top-left of the pane to toggle between the two modes.

Edit Mode - In Edit mode, immediately under the mode toggle buttons are standard tape deck
icons providing hot buttons for the Play process. They are:

l4d  Go-to-Previous “Most Significant” frame M Reverse 1 frame

44 Rewind (8x) 4 Reverse Play

sl B Stop

»  Play (1x) P> Fast Forward (8x)

M Forward 1 frame PPl Go-to-next “Most Significant” frame

l Play Entire Clip or Marked Segment

Play Mode Arrow
Edit Mode Play Controls and Scrub Bar

Below the Play buttons is a Scrub Bar that allows you to click and drag along the loaded
sequence to view individual frames and mark In/Out- points for playback of frame subsets. To
set an in-point, click on the left bracket. To set an out-point, click on the right bracket.

To set an in-point, click on the left-most hot text numeral below the bar and enter the desired
frame number. Similarly, enter the out-point by clicking on the right side hot text numeral.

Note: The “first” or “last” frame may be for the entire sequence or for frames in an in/out-
marked subset. In this case, first, last, in, and out frames become “Most Significant Frames.”
For example, clicking on the Go-to-1st button will move you to the first Most Significant
Frame to the left. Clicking on the Go-to-Next button will move you to the first Most
Significant Frame to the right.

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x.
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Play Modes

Select a Play type by clicking the Play hot toggle buttons above the controls. Choose
between: Play All or Play Range.

You can select one of three Play Modes by clicking on the Play Mode arrow to the left of the
slider control. You will step through the following modes:

* Once (single arrow) — play once through in forward or reverse

* Bounce (double-ended arrow) - play continuously, alternating between forward and
reverse play

* Loop (double right-pointing arrow) — play repeatedly, looping in one direction

If you have designated an In/Out sub-segment you can use the hot text brackets (to the right
of the Play Mode arrow) to play either the entire clip [ ] or the marked segment
only {}.

Output Modes Toggle the Play Mode to Output and standard VTR controls and machine control timecode
hot text will appear. Beneath the Output mode header are hot-buttons that allow you to
choose between two modes of output—Insert Edit or Print-To-Video. Print-To-Video and
Insert Edit will output the loaded clip from its in/out- points (if any exist) or from the first to
last frame (if no in/out-points have been set).

Qutput { 00;00;00;00 00;00;00;00 00;00;00;01 Play Status
Insert Edit
Stop
+/ Preview Edit > >> 00:00:00:00 (0)
00:00:00:00 (0)

I«

Oftfline 00:00:00:00

Play Controls for Insert Edit

Insert Edit

In this mode, you can select the Video/Audio content that you want to insert by checking the
desired content boxes at the left. Then set an in-point that the recording VTR will use to
initiate recording of your segment. Duration is determined by the length of the clip you are
outputting.

Note: The Preview Edit check-box controls whether the insert edit is in “Preview” mode or
not. In preview mode, the deck never goes into record but just simulates the edit without
putting anything to tape. You must un-check this box to perform the actual Insert Edit.
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Print-to-Video Mode

This mode allows you to manually put a clip to tape using the VTR’s current position. You have
the option of adding Delay frames. KONA will wait this many frames after the tape machine’s
start command, before it outputs the clip. The Duration Field displays the total length of the clip
that will go to tape. Click on the green hot button to launch the output sequence.

Output 00;00;00;01 Play Status
Print To Video

Stop

P PP 00:00:00:00 (0)

00:00:00:00 (0)

1
[ >
L 4

Offline 00:00:00:00

Play Controls for Print-to-Video

Assemble Edit Procedure

Assemble Edit features exist in both Machina and the AJA capture Plug-in for Premiere Pro.
These features create a two step process for Assemble Editing. The procedure require the tape
to have at least a few seconds of timecode already on it. If it does not have any timecode, a small
segment near the front of the tape must be blackened to provide this initial timecode. This
procedure assumes you are using a blank tape:

1. Blacken the Tape — This must be done in Machina
a Insert the tape and be sure it is cued to the right location
b Verify that the video cables and RS422 are connected correctly

C Inthelower left hand corner of the “Play” tab in Machina, set the “Edit/Output” toggle to
“Output”.

Qutput 00:00:12:30
Blacken Tape

> >>

I« >

B
n
L 2

Offline 00:00:00:00

Blacken Tape Mode

d Next set the toggle button below, to “Blacken Tape”

€ Inthe timecode clock to the immediate right of the toggle buttons, enter your desired
beginning timecode

f Click the green “Record” button and allow the deck to blacken about 30 seconds of the
tape
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2. Punch-In Assemble (This can be performed either in Machina or Premiere Pro)
a Cue the tape to a location where there is timecode

b Setthe edit toggle to “Punch-In Assemble”

« Output » { 00;00;00;00 00:00:00:00 00:00:00:01
4  Punch-In Assemble *

<< < > >p

]
I« | >l
L 4

Offline 00:00:00:00

Punch-in Assemble Mode

C Specify the timecode where you would like the “Punch-In" to begin
d Set the timecode generation setting on your deck to “regen”

e Click the record button to begin the assemble edit.

Play/KONA Status

Click on the hot toggle buttons of the Status header to switch between Play Status and
KONA Board Status. Play Status reports current state of activity, play duration selected for the
current playback, total number of frames in (), and lastly, the number of frames that may have
been dropped. KONA Status reports Active/Inactive status, Primary Format setting, Video
Input type, and Audio Input type.



Chapter 5: Using Adobe CS5 Applications

Overview

There are KONA plugins for both Mac and Windows versions of the Adobe Applications and
functions are virtually the same. This chapter will describe the Windows menus and note
exceptions.

AJA Software for KONA is tightly integrated with Adobe Premiere Pro CS5, Photoshop, and
After Effects (not included with KONA). KONA allows a user to bring in supported Premiere Pro
CS5 compressed formats and provides plug-ins and drivers that add functionality to the
Premiere Pro application.

Note: You should have Adobe CS5 applications installed on your workstation before
installing KONA software. The KONA installation adds required files to your Adobe
application directories. Also, CS5 pluggins for Mac come in a separate installer that must
be run along with the standard KONA for Mac installer. See KONA downloads at:

http://www.aja.com/support/index.php

After you install the KONA software on your workstation, all you need to do to begin using it is
to become familiar with the AJA plugins and how Adobe CS5 applications access
KONA options.

The manual you are reading does not provide operational information for Adobe CS5 except
as related to KONA operations. Please read the Adobe Premiere Pro, Photoshop, and After
Effects CS5 user documentation for information on configuration and operation.

Note: AJA Windows Software operates on both AJA KONA cards and lo Express at different
functional levels. Some setup screens may use either KONA or lo Express interchangeably
when referring to your AJA capture hardware.

The chapter you are reading addresses configuration and setups supported by KONA. Topics
covered include:

* Adobe Premiere Pro Realtime Performance
* Beginning a Project with KONA Presets

* KONA Capture Options

* KONA Playback Options

* Using Adobe Photoshop CS5

* Using After Effects CS5
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Adobe Premiere Pro Realtime Performance

With KONA, Adobe Premiere Pro CS5 can perform the following functions in Realtime:

* KONA LS can capture uncompressed analog or digital SD, component, composite, or
S-Video to the supported file formats.

* KONA LHi can capture uncompressed analog or digital SD and HD, component or
composite, or S-Video to the supported file formats.

* KONA 3/3x can capture uncompressed digital SD or HD via SDI or Dual Link and
uncompressed digital 2K via HSDL at 15 fps to the supported file formats.

* Playback of DPX, Cineon, Tiff, Targa, BMP, Quicktime, AVI, YUV, and HDV MPEG.

Note: This happens automatically. Files of these types that match the resolution and frame
rates of the projects will play in realtime as long as they are uncompressed and in one
of the supported colorspaces. The exception is HDV, which of course is compressed. For
HDV to playback RT it must be in a 1080 project and the frame rate or the file must
match that of the project.

* Crop — happens automatically when an imported file is too large for the project size.
Using Premiere Pro’s Motion Effects positioning, this realtime crop is keyframable
(Timeline Option “Render RT files of different resolution” box must be unchecked).
This also occurs when you use the Adobe Crop effects which can be found in the
effects folders under Transform.

* Up/Down/Cross Convert the playback from the timeline. (Cross- and up-convert are
supported by the KONA 3 card only.)

KONA accelerates the following Adobe Premiere Pro CS5 effects making them realtime:

Note: Color effects are accelerated to realtime on LHi and KONA 3 modules only, not on
the LS.

* Brightness Contrast

* RGB color balance

* Arithmetic (except for Slice and Screen Operators) see Premiere Pro Documentation
¢ Invert (some Operators are not in realtime)

* Gamma

* Clip

* Crop

Real-time KONA accelerated AJA Effects (found in the Effects window in Premiere Pro under
AJA Effects) include:

* Gamma/Gain/Offset
* Brightness/Contrast/Pivot

* Log to Linear Conversion
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Beginning a Project with KONA Presets

Opening Adobe Premiere Pro CS5, you will select New Project from the Quick Start Screen and
choose an AJA Capture Format from the pulldown menu, name the project, and click OK to
access the New Sequence setup panel with presets or click the AJA Setup button to customize
your workflow in the Capture Options panel “Capture Options” on page 68.

et

General
Action and Title

Title Safe Are % horizontal % vertical

Action Safe Area % horizontal %% vertical

Video

Display Format: ' Timecode

Audio

Display Format: | Audio Samples

Capture
Capture Format: | A1A QuickTime Capture
oV
HDV
Al AVT Capture
AJA QuickTime Capture

Video Rendering a

Renderer:

AJA Sequence Capture

Location: | C:\Users\demo ocumentsiidobe\Premiere Proi5.0

Mame: Cancel

KONA Adobe Premiere Pro CS5 New Project panel
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Preset Description

& Compressed
[ Uncompressed
= _

pressed

[ Uncompressed

s5D
M DV

[

New Sequence Setup Panel

Using the New Sequence Setup panel, you can select from AJA Presets. The KONA Presets
offer typical project settings.

The Description field summarizes the parameters for each preset including:

* Frame raster size * Timebase

* Frame rate * Pixel Aspect Ratio

* Field order * Audio sample rate

* Capture file format * Video Rendering format

* Sequence settings

You can adjust the preset Capture setting by going to Project>Project Settings>General to
access the AJA Setup menu. See “Capture Options” on page 68..
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Options Set in Some settings that determine both capture and playback characteristics for KONA are accessed
Premiere Pro through Premiere Pro Preferences.
Preferences In Adobe Premiere Pro CS5 Preferences (under Edit>Preferences) you can set up global (default)

settings for:
¢ Audio Hardware
* Audio Output mapping

¢ Device Control

Audio Hardware

Select “Premiere Pro WDM Sound” from the pull-down menu for your audio hardware. If you see
“KONA ASIO” do not select it for use with KONA..

General
Appearance Default Device: | Premiere Pro WOM Sound v

ASI0 Setting= [ Premiere Pro WDM Sound

Player Settings
Titler
Trim

Audio Hardware Preferences



Device Control
Device Control Options are settings for the RS-422 machine control interface on KONA.

Always us the AJA Serial Control and the KONA RS-422 port for KONA capture

General
Appearance Devices: serial Control Options...

Audio
SETITE reroll: seconds
tput Mapping

§ frames

Med -
i Board: 1Type: Kona 3 vI Active

Memory
Player Settings
Titler Options

Trim
weer -

Timecode: LTC =

Frame Offset: 0

[~ Enable Embedded SDITC

Edit>Preferences>Device Control>Options

Enter the desired value for:

Preroll - 0 to 15; the number of frames required to start the source machine before
capture.

Timecode Offset — -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and that of
the captured sequence.

Click on the Options button to pull up the AJA Device Control window.
Timecode Format - Use this pull-down to select the timecode base supported by your VTR.

* Base 24

* Base 25

* Base 25 NDF (50 frames per second)
* Base 30 DF (30 frames per second)

* Base 30 NDF (30 frames per second)
* Base 30 DF (60 frames per second)
* Base 30 NDF (60 frames per second)
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The timecode format is used for both monitoring the RP-188 timecode embedded in the digital

data stream and for selecting a timecode offset (if required) for the attached VTR (connected to
KONA's RS-422 port).

Timecode Source

Choose between a separate-channel Longitudinal Timecode (LTC) or Vertical Interval Timecode
(VITC) transported in the video signal’s vertical interval or include both (LTC + VITC).

Premiere Pro Capture Options Panel

Using the Capture Options panel you can change or adjust details for the selected Preset. The
following settings can be accessed:

* Capture Options - change Capture Format for the Adobe Premiere Pro CS5 project and
access settings for KONA Capture.

* Desktop display options

* File video/audio formating options

i Capture =

Camera Mode. Logging Settings

Capture Settings

Capture Locations

Video: | Same as Project ¥ Browse...
Path: C:\User...Documents\Adobe\Premiere Prols.0

d
/
7

AJA VIDEO SYSTEMS INC

A Serial Control

Options...

Current Device: Standard VTR

Preroll Time: [ENIl seconds
Timecode Offset: [N frames

Abort capture on dropped frames

AJA Capture Options panel
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Capture Options Under Capture Options, select the appropriate formats and settings for your project.

Primary and Secondary Video Options Supported by KONA

In KONA operation, the Primary Format is the captured media format written to disk—the
video format used in your current project. Secondary format is used to perform up-, down-,
and cross-conversion of the input or output video. Selections vary according to the particular
Primary format used.

Analog output is always available.
Note: No frame-rate interpolation is applied for conversions from on frame-rate to another.

See “Selection of Primary & Secondary Formats ” on page 31. for more video format and
conversion information.

YUV<->RGB Range

This control mode is not often used in most workflows. For information refer to “YUV<->RGB
Range” on page 44.

Video Input

Use the Video Input pull-down menu to select the appropriate signal type of your input. (The
current selection is reported in the display of the pull-down menu.)

Video Input always shows all the available input options based on your Primary and
Secondary format configuration. KONA software looks at 1) what model you have, 2) Primary
Format, and 3) Secondary Format (in that order) to determine what input options are
appropriate. Video Input Options Supported by KONA cards include:

¢ Single Link SDI. * Component Betacam NTSC-J
¢ Composite NTSC. * Component SMPTE NTSC-J

* S-Video NTSC-. * Composite PAL

* Component Betacam NTSC. * S-Video PAL

* Component SMPTE NTSC. * Component Betacam PAL

* Composite NTSC-J. * Component SMPTE PAL

¢ S-Video NTSC-J. * Component XVGA (HD only)
* Dual Link HD (KONA 3 only)- * HSDL (KONA 3 only)

KONA P2, XDCamHD, XDCamEX, and AVCHD Support

In Premiere Pro, P2 MXF files are also supported, with no capture, rendering, or re-wrapping
required. These files may be simply imported into the desired projects either directly from a
P2 card, or after being transferred from a P2 card to the local system. They can be used in
KONA DVCProHD projects, or in full-raster uncompressed projects.

For more information on using DVCProHD for:
* Compressed Online Editing,
* Compressed Offline Editing,
* Import, Editing, and Playing Multiple Media Types,
¢ Cross-Platform Workflow with KONA and DVCProHD,
see the whitepaper DVCProHD Editing with KONA at
http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf
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Audio Input

Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The
current selection is reported in the Status Display.)

Audio Input Options Supported by KONA include:

* Embedded SDI
* Digital AES/EBU - XLR (using either breakout cable or breakout box)

* Digital AES/EBU - BNC (only applies if you are usinbg a breakout box with BNC connectors
for AES/EBU)

* Analog (except for KONA KONA 3)I

Note: On the KONA KONA 3, you can choose between 48 kHz AES/EBU (for standard audio) and
96 kHz AES/EBU (for extra-high quality audio).

SDI Output 1

When using KONA LS and LHi cards, the SDI outputs will be Single Link only, if there is no
Secondary Video Output Format selected. If you have a Secondary format selected, you can
choose between Single Link SDI - Primary and Single Link SDI - Secondary as your output.
KONA KONA 3 also offers Dual Link output which uses both output connectors for a single A/B
channeled output (SDI Output 2 automatically becomes Dual Link).

On KONA LHi, there is only one SDI output, but there is an HDMI output. You can independently
configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E).

Analog Output
Analog format choices in the Analog Output pull-down menu vary depending upon file format.
* Composite + S-Video NTSC. * Composite PAL
* Composite + S-Video NTSC-J. * S-Video PAL
* Component Betacam NTSC. * Component Betacam PAL
* Component Betacam NTSC-J. * Component SMPTE PAL
* Component SMPTE- * Component RGB

* Component XVGA (HD only)

Note: When SD and HD formats are available as Primary and Secondary formats, you can
choose between SD and HD raster for the Analog Output.

Audio Level
Choose between +6 dB (US) monitor level and +0 dB (EBU).

Timecode Input

Select the type of timecode used by the source video machine—RS-422, Embedded SDI (RP188)
or choose to input an External LTC timecode source input via the KONA RS-422 port.

Note: SMPTE RP 188 defines a standard for the transmission of timecode and control code in
the ancillary data space of a digital television data stream. Timecode information is
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes can
be transmitted within a single digital video data stream. Other time information, such as
real time clock, DTTR tape timer information, and other user-defined information, may also
be carried in the ancillary timecode packet instead of timecode. The actual information
transmitted through the interface is identified by the coding of a distributed binary bit.
Equipment manufacturers can use the meta data for different purposes.
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Display To Desktop
Select one of four modes of desktop display:
* Off
* Display while idle only (this mode is suggested)
¢ Display during capture only
* Display Always
Display to Desktop uses system resources and could affect performance. Choose Capture
Speed, Width, and Height as appropriate for your system’s capabilities.
Display Capture Speed
* Full Speed - Every frame is displayed to desktop during playback
* Half Speed - Every other frame is displayed to desktop during playback
* Quarter Speed - One out of every four frames is displayed to the desktop
Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is

using to draw video to your computer.

Desktop Capture Width and Height

These selections allow you to reduce the resolution of the desktop capture display. The

captured file will be full-resolution. Only the displayed image is reduced to save processing
resources during capture. The choices available are:

¢ Full Resolution
¢ Half Resolution

¢ Quarter Resolution

The Premiere Pro Project Setting>Capture menu allows you to select one of the following AJA

* Eighth Resolution

¢ Sixteenth Resolution

file formats from the Capture Format pulldown menu:

¢ AJA AVI Capture
* AJA Sequence Capture

* AJA QuickTime Capture

Within the AVI and QuickTime formats, you can select one of the following subtypes by
clicking on the Setup button to the right to bring up the AJA Capture Options menu.

Note: Capture file format options vary by KONA card model. The tables provided reflect a
comprehensive list of supported formats (for KONA KONA 3).

Under the File Options panel, select a video format subtype:

AVil files in the following Subtypes

QuickTime files in the following Subtypes

8-Bit YUV 4:2:2 — “2vuy’

8-Bit YUV 4:2:2 - “2Vuy’

8-Bit YUV 4:2:2 - ‘uyvy’
10-Bit YUV 4:2:2 - 'v210’
8-Bit RGB 4:4:4 - 'bgr’

8-Bit RGB 4:4:4:4 - 'bgra’
8-Bit RGB 4:4:4 - 'bgr’ T2B
8-Bit RGB 4:4:4:4 — 'bgra’ T2B
10-Bit Log RGB 4:4:4 - ‘R10g’
10-Bit RGB 4:4:4 — ‘R10k’
10-Bit RGB 4:4:4 - 'r10k’

8-Bit YUV 4:2:2 - “2vuy’
8-Bit YUV 4:2:2 - 2Vuy’
10-Bit YUV 4:2:2 - 'v210'
10-Bit YUV 4:2:2 - V210’
8-Bit RGB 4:4:4 - 'rgb’
8-Bit RGB 4:4:4 - 'bgr’
8-Bit RGBA 4:4:4:4 - ‘argb’
8-Bit RGBA 4:4:4:4 - ‘rgba’
8-Bit RGBA 4:4:4:4 - ‘bgra’
10-Bit Log RGB 4:4:4 - 'R10g’
10-Bit RGB 4:4:4 - ‘R10k’
10-Bit RGB 4:4:4 - 'r10k’
16-Bit RGB 4:4:4 - 'b48r’
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When you select AJA Sequence Capture, the File Options panel allows you to choose a
Sequence Type:

* TGA Sequences BMP Sequence
* DPX Sequence (LHi and KONA 3 only)- TIF Sequence
¢ Cineon (LHi and KONA 3 only)- YUV

Within these sequence types, KONA (model dependent) supports the following video formats:

DPX Sequences in the following Subtypes Cineon Sequences in the following Subtypes

10-Bit Log RGB 4:4:4 (BE) 128 10-Bit Log RGB 4:4:4 (BE)
10-Bit RGB 4:4:4 (BE) T2B
10-Bit Log RGB 4:4:4 (BE) B2T
10-Bit RGB 4:4:4 (BE) B2T
10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

TGA Sequences in the following Subtypes BMP Sequences in the following Subtypes

10-Bit Log RGB 4:4:4 (BE) T2B 8-Bit RGB 4:4:4 B2T
10-Bit RGB 4:4:4 (BE) T2B 8-Bit RGBA 4:4:4:4 B2T
10-Bit Log RGB 4:4:4 (BE) B2T 8-Bit RGB 4:4:4 T2B
10-Bit RGB 4:4:4 (BE) B2T 8-Bit RGBA 4:4:4:4 T2B

10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

TIF Sequences in the following Subtypes YUV Sequences in the following Subtypes

8-Bit RGB 4:4:4(LE) B2T 8-Bit YUV 4:2:2
8-Bit RGBA 4:4:4:4(LE) B2T
8-Bit RGB 4:4:4(LE) T2B
8-Bit RGBA 4:4:4:4(LE) T2B
8-Bit RGB 4:4:4(BE) B2T
8-Bit RGBA 4:4:4:4(BE) B2T
8-Bit RGB 4:4:4(BE) T2B
8-Bit RGBA 4:4:4:4(BE) T2B
16-Bit RGB 4:4:4(LE) B2T
16-Bit RGB 4:4:4(LE) T2B

Audio Formats

¢ 48 kHz 16-bit PCM Mono- ¢ 48 kHz 16-bit PCM Stereo
* 48 kHz 24-bit PCM Mono- * 48 kHz 24-bit PCM Stereo
® 48 kHz 32-bit PCM Monos ¢ 48 kHz 32-bit PCM Stereo

* KONA KONA 3 also supports 96 kHz 16 through 32-bit PCM Mono and Stereo selections

Audio Tracks

Select the number of audio tracks for this project, KONA supports up to eight (four stereo pairs)
for KONA LHi/LS or 16 for KONA KONA 3. Adobe Premiere Pro CS5 supports six channels.
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Premiere Pro Playback Options

To access AJA Playback settings,in Premiere Pro, highlight (select) the Sequence Panel. Then
either use the fly-down menu in the top right corner of the Premiere Pro project window, or
go to Sequence>Sequence Settings, and click on the Playback Settings button.

Player Settings

Board: ]Kona 30 Overlay Options: [~ Enable Overlays

Led Lo

[ Missed Frame Count ™ Device
[~ safe Titles [~ Format
[~ Timecode [~ Clip Name

Audio Device:  [AJA Audio

Primary Format: 1920x1080i @ 29.97

Secondary Format: ]?2[)3(486 @ 29,97
HDMI Quiput Options:

Conversion Mode: |Letterbox

Protocol:

SDI 1 Qutput: |Primary

Color Space:

501 2 Output: |Primary Audio Channels:

HOMI Output: |

Video Range:

Analog Output: |Compnnent SMPTE
General Options:

Led Lol Leflefle] Ledel

Reference: |Free Run
[~ stop on dropped frame

Advanced Options:
P [~ Disable segmented frames

Shared Cutput: |Normal

Lo

[~ Monitor Level +6 dB

Stereoscopic
Video + Key

Ok | Cancell

Player Settings Panel

Note: Primary Format, SDI and HDMI Outputs have the same functionality as described in
the Sequence Capture Options panel. See “Capture Options” on page 68..

Audio Device

Select “AJA Audio” to output your project audio through the KONA. To complete audio setup
refer to “Options Set in Premiere Pro Preferences” on page 65.

Analog Output

Analog Output Options Supported by KONA include:
* Composite + Y/C
* Component (SMPTE/EBU N10)

* Component (Beta)
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Reference:

Select a source for the video reference signal:
* Free Run (hone) ¢ Reference Input (LTC/Ref connector)
* SDI Input ¢ HDMI Input

Overlay Options

Enable and select overlay information to be included in the playback by checking the
appropriate boxes. These overlay controls allow you to insert a graphic file supporting alpha
channel transparency to apply an effect or insert a bug (logo) over the video content.

HDMI Output Options

HDMI video output offers these options:
* Protocol - choose Auto Detect, HDMI, or DVI
* Color Space - select Auto Detect or YCbCr 10bit (KONA does not support RGB)
* Audio Channels - choose 8 or 2 to be embedded

* Video Range - select SMPTE or Full Range

Advanced Options
Under the Shared Output pulldown, you have these options:

* Normal- choose for normal output connector routing

* Stereoscopic — select for use with Cineform First Light to control the 3D output. When
selected and used with KONA 3, the stereoscopic playback will be output on separate SDI
outputs, left and right. (For playback output on a single SDI output, you can configure
Cineform First Light to superimpose the left/right; see Cineform First Light documentation
for details).

* Video + Key - choose this selection to output a video signal to one SDI output and a related
Key signal to a second SDI ouput (useful for outputting to a video switcher for example).
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Using Photoshop CS5

Adobe Photoshop CS5 (not included with KONA) accepts KONA plugins and drivers to closely
integrate KONA functions into the application. After you install the KONA software on your
workstation, all you need to do to begin using it is to become familiar with the Plugins and
how Photoshop works with KONA.

With Photoshop open, you'll go to the File pull-down menu and select Import>AJA Capture to
set up your workflow, source device control, and other KONA options. Then access
Export>AJA Preview Setup to configure the preview output to your monitor. Quick capture
and simple send-to-preview functions are also available in these menus.

The manual you are reading does not provide operational information for Adobe Photoshop
CS5. Please read the Photoshop user documentation provided with the application for
information on configuration and operation. The chapter you are reading addresses
configuration and setup unique to use of KONA with Adobe Photoshop CS5.

e E M v oo @y =

[File] Edit Image Layer Select Filter Analysis 3D View Window Help

New.. Cert+N ‘ Style:  Mormal ~ \Width
Open... Ctrl+0
Browse in Bridge... Alt+ Ctrl+ O
Browse in Mini Bridge...
Open As... Alt+5Shift+ Ctrl+ O
Open As Smart Object...
Open Recent 4
Share My Screen...
Create New Review...
Device Central...
Close Ctrl+W
Close All Alt+Ctrl+W
Close and Go To Bridge... Shift+Ctrl+W
Save Ctrl+5
Save As... Shift+Ctrl+5
CheckIn...
Save for Web & Devices... Alt+Shift+Ctrl+5
Revert F12
Place...
Variable Data Sets...
Export » Video Frames to Layers...
AlATmage Capture...
Aut t 4
u.oma s AJA Quick Image Capture...
Scripts 4
Notes...
File Info... Alt+Shift+Ctrl+I WIA Support...
Print... Ctrl+P
Print One Copy Alt+5hift+Ctrl+P
Exit Ctrl+Q

AJA Image Capture in Photoshop File>Import Menus

The KONA Photoshop plugin is a software application that is integrated into the Photoshop
CS5 application and is accessed under the File menu. The Capture plugin provides you with
standard tapedeck style play/record functions, status display, and configuration options. The
Preview plugin allows you to adjust output formats and view your current project frame on a
monitor connected to a KONA output before rendering to file.

In this section, you will read about the various pull-down options, hot-text entry fields, and
play/record controls and how they interact.
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Note: The specific options available to you are determined by the AJA capture device that is
installed in your workstation and you are currently controlling. This section will describe all
options for the Photoshop plugin when used with KONA.

There are three functional areas in the Capture screen as indicated in the following illustration—
Status Display, Play/Record Controls, and Configuration Options.

Status Display
-
e e . =
Cptions - Kaona Options Irnage Cptions Fenaral
Board: 1 Type: Kona 3 -
Frimary 1920:x1080 & 2997 Capture Status: Unknown Mideo Format
Activation Options
Video Input:  Single Link SDI 1 - Primary
Colorspace:  S-bit RGE 4:4:4 | ek fsim
Device Control: Mot Active
Activation Maode: Auto -

Capture Options

Prirmary Forrmat:
Secondary Format:
Convert Mode:

YUY-=-RGEE Range:

192010280 @ 29.97i
T20x486 @ 29.97i ()
Anarnorphic

CaR

Yideo Input: Single Link SDI 1 - Primary
Audio Input; Ernbedded SO

S0 Cutput: Single Link SCM

SDIZ Sutput Single Link S0l

dnalog Cutpot:

Corpanent SWPTE

Audio Lewvel: Gain @ & dB
WTR TC: 00000000 i ;0000 0;00;00 i Display To Desktop: Off
WTR Status: Qffline InfOut Duration:  0;00;01 Timecade Input: RS422

[

Capture Mow

fccept

-

KONA Photoshop Capture Plugin Layout

The Status Display area is read-only information about configuration, current status, and
performance.

The Play/Record Controls offer standard tapedeck controls and more. The hot-text fields
beneath the video display are for writing and reading timing data. Capture mode will determine
which fields are operational.

Note: Capture Play controls are RS422 machine controls for running a VTR tape deck with
timecode data.

* The Configuration Options section contains tabbed menu selections that provide:
* KONA Options — KONA workflow configuration options

* Image Options - Image formatting colorspace, frame, and crop information
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If you don't see the Configuration Options section, click on the Options triangle switch above
the Status Display. In normal operation, you may decide to hide this section when it is not

needed.
-
o L ==
COptionzs = Kona Options Image Cptions General
Board: 1 Type: Kona 3 -
Primary 1920x1080 & 2997 Capture Status: Unknown Yideo Format

F t Copti
Yideo Input:  Single Link SDM 1 - Primary armat Lptions

Colorspace: S-bit RGE d:4:4 Colorspace: S-bit RGE 4:4:4 hd
Frame Scan: ane had
Set Alpha Channel: 255
Crop Image: Top
1050
Left Right
u] u}
Bottorn
1920

WTR TC: 00:00:00:00 i 0;00;00 0;00;00 *
WTR Status: Cffline In /Ot Duration: 0;00;01
e - 11 - [ . Capture Mow
| | g
.} Accept

File>Import>AJA Image Capture

Configuration The first Configuration Options tab selects the KONA Options panel for setting Board
Option Panels Activation mode and Capture format options.

Activation Mode

A KONA plugin can be set for Automatic or Manual activation using the Activation Mode pull-
down menu. Automatic is the default setting and is recommended for normal operation. In
this mode, you merely click between the open plugins to make one active.

Note: Only one plugin window can have control of the AJA capture device at a time. If the
window you click on does not access the KONA (reporting Board: Active), either another
window is still processing operations or it is set in Manual activation mode and must be
disabled (check-box empty).

In Manual mode, you must check the Enable KONA box to activate the board control and un-
check it to release control. Upon startup of either Photoshop CS5 application, if the launched
plugin window is in Manual mode, the window will NOT activate until the enable box is
clicked again.



Using the AJA
Capture Plugin

Using Adobe CS5 Applications — Using Photoshop CS5

The Preview plugin does not need activation since it grabs only one frame (the current working
frame) at a time for output to the monitor. It grabs the data on a priority basis when it can. The
rest of the time it is off.

First, activate the KONA from the Capture window and set up your workflow by defining Input
and Output formats and timing options. To do this, click on the KONA Options tab. (KONA stores
the workflow settings you make until they are next changed.) Next, access the Image Options
tab to set colorspace and framing options and make Alpha Channel (for RGBA scanned-in
images) and image crop settings if required. Finally, use the General Options menu to set
timecode and other machine control options.

Kona Options Irmage Cptions Genetal

Activation Options

Board:
Device Contral:

Activation Mode:

Capture Options

Primary Format:
Secondary Format:
Canvert Mode:

YUY-=-+RGE Range:

Active
Active

At -

ToOw4GE @ 29,97
19201080 @ 29.97i (I}
LettarBox

CGR

Video Input: Single Link S0 1 - Primary
Audio Input: Ernbaddad SDI

S0 Cutput: Single Link SDI

S0I2 Cutput: Single Link S0

Analog Cutput:

Component SMPTE

fudio Level: Mone
Display To Desktop: While 1dle Cinly
Tirmecode Input: R5422

KONA Options Menu

Capture Options
These options are the same as those for Premiere Pro except for Display to Desktop. See
“Capture Options” on page 68..

Display to Desktop allows you turn off the desktop capture display or “Display while idle only.”
The latter is the suggested mode.
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Image Options After configuring KONA Options, select the Image Options tab. In the Image Options menu
Menu there are four configuration settings—Colorspace, Frame Scan, Set Alpha Channel, and Crop
Image.
Kona Options Image Options General . KONA LSe options shown

S-bit RGE 4:4:4
S-bit RGBA 4:4:4:4

Format Options

Col : B8-bit RGB 4:4:4 —
olorspace i : = 16-bit RGE 4:4:4
Frame Scan: Full Frame >|— 16-bit RGEA 4:4:4:4
Set Alpha Channel:
- : Full Frame
rop Image: ;P Ewven Field Only
e Fnt Cdd Field Onljlt
. ah Double Even Field
Double Cdd Field
Bottom

1080

Photoshop Plugin Image Options Tab

Note: You can enlarge the thumbnail capture image to full-screen by double-clicking on the
image. To return, double-click again.

Colorspace - Choose between 8- and 16-bit color in either RGB 4:4:4, or RGBA 4:4:4:4 mode.

Frame Scan - Work with a Full Frame or capture Even or Odd fields only in single or double
modes.

Set Alpha Channel - The Alpha channel image applies only to RGBA scanned-in images and
then you can set it to 255 (default) which is zero transparency or 0 which is 100 percent
transparency when the image is imported into Photoshop.

Crop Image - Use the hot text fields to enter value for pixels cropped from Top, Left, Right,
and Bottom of the captured image. When you import (Accept) the image into Photoshop, it
will be cropped to these specifications.
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General Options Under the General tab, you will find Device Control Options. These functions are for the
Menu RS-422 machine control interface on KONA. They support Print-to-Tape machine control.
Kona Options Irnage Dptions Fenaral

Dewvice Control Cplions

Timecode Format: Base 24 -
Timnecode Source: LTC -
Freroll: 2 Seconds

T Offzet: 0 Frames
General Options Tab

Under the General tab, you will find Device Control Options. These functions are for the RS-422
machine control interface on the KONA card. They support Print-to-Tape machine control.

Timecode Format - Use this pull-down to select the timecode base supported by your VTR.
* Base 24
* Base 25
* Base 25 (50 frames per second)
* Base 30 DF (drop-frame, 30 frames per second)
* Base 30 NDF (non-drop-frame, 30 frames per second)
* Base 30 DF (drop-frame, 60 frames per second)

* Base 30 NDF (non-drop-frame, 60 frames per second)

Timecode Source - Choose between a separate-channel Longitudinal Timecode (LTC) or
Vertical Interval Timecode (VITC) transported in the video signal’s vertical interval or include
both (LTC + VITC).

Click on the Hot Text items to enter a value for:

* Preroll - 0 to 15; the number of frames required to start the source machine before capture

* Timecode Offset — -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and that of the
captured sequence.

Status Display If you have more than one AJA capture device installed in your workstation, you can select
another device to work with by using the Board pull-down menu at the top. If they are set for
Auto Activation and are idle (not processing), you will immediately take control of the new
Board (see Basic Plugin Operations and Configuration).

oplions =
Eoard: 1 Type: Kona 3 -|

Primmary 1920:1020 & 2997 Capture Status: Unknown Yideo Format
Video Input:  Single Link S0 1
Colorspace: S-bit RGE 4:4:4

Photoshop Capture Window Status Display
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The Status Display section of the Photoshop Capture plugin, in the left column, reports the
settings that you have selected for the KONA to use when you have control of it:

* Primary Format
* Video Input type
* Selected Colorspace
In the right column Capture Status reports the detected signal status of the KONA input:
Off Line — the capture plugin does not control the KONA

Idle — Ready, the plugin has control and the proper input signal is present
Video Input Not Detected — no input present

Standard tape deck icons provide hot buttons for the Play/Record RS-422 machine control of a
source VTR. They are:

44 Rewind (8x) B Fast Forward (8x)
4 Reverse Play M Reverse 1 frame
sl B Stop
> Play (1x) M Forward 1 frame

The slider on the bottom is a variable speed forward/reverse control. Positions from left to
right are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x. The red
Record button is used to initiate a capture.

WTR TC: O0:00:00:00
VTR Status: Offline In A0t Duration: 00:00:00:01
o - 1 . (. . | Capture Now
(| | [
— hiccept

Photoshop Capture Window Play/Record Controls

The pull-down menu on the right enables one of two capture modes:

* Capture Now — manual record/stop (“crash”) capture

* Capture In/Out - initiate a capture using timecode-based in or out settings

The selected mode will activate the appropriate hot text for that mode. Clicking the hot text
brings up and entry field (hours:minutes:seconds:frames). The upper left display indicates the
current timecode from the VTR.
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Capture In/Out - Enter a timecode Capture point by clicking on either the left field or right field
of eight digits in the bracketed fields above the In/Out Duration field. Since Photoshop capture
is a single-frame function, the In and Out settings will always be the same and the frame
duration will always be one frame.

Note: The in-point/out-point field values are inclusive. When both are set to the same value,
the capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the
bracket ({or}) next to the field.

VTR TC - The VTR timecode field displays the current machine timecode and you can click on it
to roll the VTR to another frame setting. The VTR must be online and in remote rather than local
control mode (as reported in the VTR Status field.)

Accept - When you have successfully captured the frame you wish to use in Photoshop, Click on
Accept in the bottom right corner of the Play/Record pane. The KONA capture plugin will close
and your frame will be opened in Photoshop for editing.

Using the AJA The Preview Plugin allows you to view on a monitor the current frame you are working on in

Preview Plugin Photoshop CS5. Go to File>Export>AJA Preview Setup to configure previews. When you have
Preview Setup the way you want it, subsequent Previews are output by selecting AJA Preview
(below AJA Preview Setup).
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New CuleN = ,
i) Open_. Cule0 Fed L
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";' Open Recent ’
g Share My Screen..
ﬁ\. | Device Central...
| Close CerdeW
/' Close All Alte Crrie' W
y, Clese and Go To Bridge... Shifts Cerle W
FARE CerleS
_6 Save As. Shift«Cerl+S
c | Checkin.
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AJA Export Plugins for Photoshop
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The pull-down menu at the top allows you to select any AJA capture device you have installed
in your workstation (subject to Activation rules). A check box is provided to enable/disable the

Preview function.

e

AJA Preview Setup
— Board: 1 Type: Kona 3 '!
< Summary
Primary Format: 1920x1080 @ 29.97i
Resize Enabled
SDI1 Qutput: Single Link SDI - Primary
SDI2 Output: Single Link SDI
Analog Output: Cornponent SMPTE
Reference: Free Run
' 8-bit Project: 3-bit RGBA 4:4:4:4
16-bit Project: S8-bit RGBA 4:
32-bit Project: 8-bit RGBA 4:4:4:4
YUV SD Matrix: 601 CGR
YUY HD Matrix: 709 CGR
| LUT: Disabled
< Preview Options
|
Prirary Format: 1920x1080 @ 29.97i -/
"
K Auto Resize Image
Secondary Format: Mone "f
| Convert Mode: None V[
| YUV<->RGE Range: CGR -/
| SDI1 Output: Single Link SDI A
SDI2 Qutput Single Link SDI Vf
[l Analog Output: Cornponent SMPTE '[
Reference: Free Run v[
0 RefH Offset
0 RefV¥ Offset
<z Color Options
Output 8-bit As: 3-bit RGEA 4:4:4:4 - |
Output 16-bit As: 8-bit RGBA 4:4:4:4  w|
|
Output 32-bit As: 8-bit RGBA 4:4:4:4 v/
I :
YUY SD Matrix: 601 CGR v|
YUY HD Matrix: 709 CGR "[
o LUT: Mone [l
< Test Options
I Test Patterns: 1003 ColorBars VE
Upload Test Pattern |
OK | Cancel |

AJA Preview Setup Menu

for Photoshop
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The Summary section reports current configuration settings.

In Preview Options, Primary format is the current format you are using for your project. KONA
does not support conversion so the Secondary signal format and Convert mode are inactive.
One SDI output is available and it is always Single Link. Select Analog output type (as

applicable), and select timing Reference mode—Free Run, External (genlock), or from the video
Input signal (SDI or HDMI).

In Color Options, KONA does not support colorspace conversion so this function is inactive.

Finally, for picture quality adjustment, you can output a Test Pattern selection using the pull-
down menu under Test Options. Click OK to output your Preview
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Using After Effects

KONA After Effects
CS5 Plugin
Overview

KONA After Effects CS5 plugins add KONA functions to the After Effects CS5 application. Three
KONA plugin screens are accessed under the Window pulldown menu. The Capture and
Playback plugin screens allow you to see and edit how the KONA workflow is currently
configured for recording, storage, and playback of your video and audio data. They provide
you with standard tapedeck style play/record functions, status display, and configuration
options. The Preview plugin allows you to view the current frame of your working timeline in
various formats on a monitor connected to a KONA output.

In this section, you will read about the various pull-down options, hot-text entry fields, and
play/record controls and how they interact.

Note: The specific options available to you are determined by the currently active AJA
capture device installed in your workstation. This section will describe all possible options
for KONA.

There are three functional areas in both the Capture and the Playback screen as indicated in
the following illustration (AJA Capture plugin screen is shown): Status Display, Play/Record
Controls, and Configuration Options.

General

In /2t Duration:

1| 1| 1| 1| 1| 1| 1| 1| 1| 1| *l *l

[ Capture Mow

Configuration Options

KONA After Effects CS5 Plugin Layout
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The Status Display area is read-only information about configuration, current status, and
performance.

The Play/Record Controls offer standard tapedeck controls and more. Hot-text fields are at the
top for writing and reading timing data (Capture plugin only). Capture mode will determine
which fields are operational.

Note: Capture Play controls are RS422 machine controls for running a VTR tape deck. Playback
controls are for KONA playout functions.

The Configurations Options section contains tabbed menu selections that provide:

* KONA Options — KONA workflow configuration options
* File Options - File path and formatting information, and
* General — General options (for machine control interface).

If you don't see the Configuration Options section, click on the Options triangle switch above
the Status Display. In normal operation, you may decide to hide this section when it is not
needed.

Basic Plugin This section discusses settings common across plugin windows and how they interact.
Operations and
Configuration Activation Mode

A KONA plugin can be set for Automatic or Manual activation using the Activation Mode pull-
down menu. Automatic is the default setting and is recommended for normal operation. In this
mode, you merely click between the open plugins to make one active.

Note: Only one plugin window can have control of the KONA at a time. If the window you click
on does not access the card (reporting Board: Active), either another window is still
processing operations or it is set in Manual activation mode and must be disabled (check
box blanked).

In Manual mode, you must check the Enable KONA box to activate KONA control and un-check
it to release control. Upon startup of the After Effects CS5 application, if the launched plugin
window is in Manual mode, the window will NOT activate until the enable box is clicked again.

After Effects CS5 and Preview Note

Double clicking on a captured Project File in the project bin will sometimes open the file in an
After Effects CS5 player which can be previewed. Some formats will result in the file openingina
third-party viewer (QuickTime for example)—but the file cannot be previewed in that viewer.

Shortcuts and Keyboard Shortcuts
Display Features Space Bar - Use it to start and stop playback of media. Pressing the Space Bar starts playback
from the location of the Edit Line.
| key — press to set an In-point when trimming a clip.

J key - press to shuttle backward through the clip. Press repeatedly to move at a faster
rate (2x, 4x, etc.).

K key — press to stop playback at the current position.

L key - press to shuttle forward through the clip. Press repeatedly to move at a faster rate
(2x, 4x, etc.).

O key — press to set an Out-point when trimming a clip in After Effects.
Left Arrow key (<-) — press to move one frame backward.

Right Arrow key (->) - press to move one frame forward.

Up Arrow key — press to start playback (forward).

Down Arrow key - press to start playback backward.
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Using the After Effects Capture Plugin

To begin using KONA in After Effects CS5, go to the Capture window (Window->AJA Capture),
ensure that KONA is activated (look under the KONA Options tab), and then set up your
workflow by defining Input and Output formats and timing options. KONA remembers the
workflow settings you make. Next, access the File Options tab to name the capture file, set file
options, and set up the path to your file storage directory. Under the General options tab you
can set Device Control timecode options.

General

Dizplay To

Tinecode Input:

KONA Capture Options Menu

Activation Options
For Activation Options details, See “Activation Mode” on page 76..

Capture Options

Under Capture Options you select the appropriate formats and settings for your After Effects
CS5 workflow.

For details on the following, refer to “Capture Options” on page 68:

* Primary and Secondary Format Options
* YUV<->RGB Range
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* Video Input
* Audio Input
* SDI Output 1
* Analog Output
* Audio Level

* Timecode Input

Display to Desktop Select one of four modes of destop display:
* Off
* Display while idle only (this mode is suggested)
* Display during capture only
* Display Always

File Options Menu

After configuring KONA Options, select the File Options tab. In the File Options tabbed menu
there are three operation panes below: File Options, Clip Options and Location Options.

aeneral

Audia Format:

y Name:

1BE.9% GE &vailabla

Audio Path:

155,95 QB Available

File Options Menu

In the File Options pane you will select the capture file type, capture content (video/audio),
video format, audio format and the number of audio tracks included.
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Type The Type pull-down menu provides a choice of video/audio file formats:

* QuickTime Movie. * TGA Sequence
* AVI Movie (not supported in Mac) * BMP Sequence
* TIF SequenceYUV Sequence (8-bit only)

Capture Use the Capture pull-down menu to select the video/audio input combination you
will capture:

* Video Only

¢ Audio Only

* Video - (minus) Audio - video and audio are recorded in separate files

¢ Video + (plus) Audio (QuickTime only) — video and audio are recorded in the same file

Note: The options shown are determined by the file format selected. QuickTime captured
audio is either embedded with the video file or captured to separate .mov files. All other
formats capture audio to Wave Files.

Video Format Video Capture Formats supported by KONA include:
* 8-bit YUV 4:2:2 - “2vuy’
* 8-bit YUV 4:2:2 - ‘2Vuy’
* 10-bit YUV 4:2:2 - 'v210’

Audio Format Audio Capture Formats supported by KONA include:.

¢ 48 kHz 16-bit PCM Mono- ® 48 kHz 16-bit PCM Stereo
* 48 kHz 24-bit PCM Mono- ® 48 kHz 24-bit PCM Stereo
® 48 kHz 32-bit PCM Mono- ® 48 kHz 32-bit PCM Stereo

Audio Tracks Select the number of audio tracks for this project.

Clip Options

Clip Name In the Clip Options menu, click on the Clip Name hot-text to name the file you
will be creating. Subsequent capture file numbers will increment from this one.

Reel Name Click on the hot-text field to enter a source tape name (the name of the tape on
the VTR). Only QuickTime and DPX files store this information.

Sequence Offset When capturing file-per-frame sequences, after naming a file, you can set
a Sequence Offset number that will determine the beginning number of the file sequence.

Create New Folder Per Sequence A check-box is provided to enable this automatic
function. When you check this selection, After Effects CS5 will gather each frame capture
sequence in a new folder, based on clip names, on your disk. (Not applicable to QuickTime or
AVI movie files.)

Import Clip After Capture This function imports the completed capture file into After
Effects CS5 Project window.
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Location Options In the Location Options pane, enter the path to the RAID location you have
dedicated for Video and Audio captures.

After KONA and File Options are configured, you are ready to perform your video/motion
graphics capture.

General Menu - Device Control Options
Under the General menu you will find settings for Device Control Options.

Device Control (RS-422) Settings

Device Control Options are settings for the RS-422 machine control interface on the KONA. The
timecode format is used for both monitoring the RP-188 timecode embedded in the digital data
stream and for selecting a timecode offset (if required) for the attached VTR (connected to the
KONA RS-422 port).

Timecode Format Use this pull-down to select the timecode base supported by your VTR.

* Base 24

* Base 25

* Base 25 (50 frames per second)

* Base 30 DF (drop-frame, 30 frames per second)

* Base 30 NDF (non-drop-frame, 30 frames per second)
* Base 30 DF (drop-frame, 60 frames per second)

* Base 30 NDF (non-drop-frame, 60 frames per second)

Timecode Source Choose between a separate-channel Longitudinal Timecode (LTC) or
Vertical Interval Timecode (VITC) transported in the video signal’s vertical interval or include
both (LTC + VITC).

Click on the Hot-text items to enter a value for:

* Preroll - 0 to 15; the number of frames required to start the source machine before capture
* Handles - 0 to 60; the number of frames added to the front and back of a sequence for
editing flexibility

* Timecode Offset — -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and the captured
sequence.
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Status Display

The Status Display section of the AJA Capture plugin, in the left column, reports the settings
that you have selected for the KONA to use when you have control of it:

* Primary Format
* Video Input type
¢ Audio Input type

Capture Plugin Status Display

* In the right column you will see current information for:
* Capture Status
* Number of frames successfully captured
* Number of frames dropped from the capture sequence
Capture Status reports the detected signal status of the KONA input:
¢ Off Line — the capture plugin does not control the KONA
¢ |dle — Ready, the plugin has control and the proper input signal is present

* Video Input Not Detected - no input present

¢ [format of input detected] - if the input is not a match with the chosen input format, the
mismatched signal format will be displayed here

Play/Record Controls
Standard tape deck icons provide hot buttons for the Play/Record process. They are:
<44 Rewind (8x) P FastForward (8x)
4 Reverse Play M Reverse 1 frame
st B Stop
®  Play (1x) M Forward 1 frame

The slider on the bottom is a variable speed forward/reverse control. Positions from left to
right are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8%, and 16x. The red
button is for Record.
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In /2ot Duration:

-

Capture Play/Record Controls

The pull-down menu on the right enables one of three capture modes:

* Capture Now — manual record/stop (crash) capture

* Capture Duration - capture a specified number of frames after manual start, based on the
timebase of the selected Primary Format

* Capture In/Out - initiate and end capture using timecode-based in and out settings

The selected mode will activate the appropriate hot-text for that mode. Clicking the hot-text
brings up and entry field (hours:minutes:seconds:frames). The upper left display indicates the
current timecode from the VTR.

Capture In/Out The capture in-point is entered by clicking on the left field of eight digits in
the bracketed fields above the In/Out Duration field. The out-point can be set by clicking on the
right field of eight digits. Or you can specify a duration in the In/Out Duration field and the in- or
out-point (whichever you have not entered) will be entered automatically according to
duration.

Note: The in-point/out-point field values are inclusive. If both are set to the same value, the
capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the
bracket ({ or}) next to the field.

VTR TC The VTR timecode field displays the current machine timecode. You can click on it and
enter a timecode to perform a seek to that timecode on the VTR. The VTR must be online and in
remote rather than local control mode (as reported in the VTR Status field).

Abort on Dropped Frame Found in both Machina and the After Effects CS5 Capture
window, this checkbox causes KONA to watch for dropped frames during a capture—if one is
found it automatically halts the capture and discards any media captured to that point.
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Using the After Effects Preview Plugin

The Preview Plugin allows you to view on a monitor the current frame you are working on in
the timeline as it will appear at the KONA output. A summary area at the top of the Preview
window shows how the KONA is currently configured. If you wish to change it, you can use the
Preview Options below.

AlA Preview Setting

05 [anrd: 1 Type: Kona 3 v] video Preview

Preview Oplions Color Options

Primary Format: [19201(1080 @ 29.97 v] Output 8-Bit As: [8-bit RGBA 4:4:4:4

Secondary Format [Nnne v] Output 16-Bit As: IB-bit RGEA 4:4:4:4

Conversion Mode Cutput 32-Bit As: [8—bit YUY 4:2:2

YUV <->RGB [CGR v] YUV 50 Matrix: [?09 CGR

SDI 10utput  |Single Link SDI = | YUvHD Matri: | 709 SMPTE

SDI20utput  [Single Link SDI 5] el Lut

Analog Output | Camponent SMPTE »| TestOptions

Reference [Free Run '] Test Patterns: [ 100%: ColorBars

|:| Auto Resize Image

J |

AJA Preview Plugin

In Preview Options, you can vary the Primary and Secondary signal formats, Convert mode,
YUV to RGB range (see earlier discussion under the AJA Capture Plugin), SDI and Analog
output type (as applicable), and select timing Reference mode—Free Run, External (genlock),
or from the video Input signal.

Color Options, KONA does not currently support colorspace conversion.

You can output a Test Pattern selection using the pull-down menu under Test Options.
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Using the After Effects Playback Plugin

Use the Playback Plugin to view rendered files that are produced from the After Effects CS5
effects timeline. You've previewed your composition, made final adjustments, and rendered it to
a movie or sequence. Now you want to view it in real-time.

The Playback Plugin offers the same functional layout as the Capture Plugin—Status Display,
Configuration Options, Play Controls but with variations suitable for playback.

_:=A.JA Playback . Kona Options “File"0ptions™. General

- Options =
Board: 1 Type: Kona 3 w File Options
Primary Format: 1920x1080 & 29.97i Analog Output: Component SMPTE T Yideo
SDI1 Output: Single Link SDI Playback Stop Format: Unknown
Col : Unk
SDI2 Output: Single Link SDI Frames Dropped: 00:00:00:00 [0) o ot 0

LUT:

" Enable Audio Scrubbing
Enable Audio Yariable Speed
Enable Audio Auto-Search
Audio Tracks 1-8
Track 01:
Track D2:
Track D3:
Track D4:
Track 05:
Track D6:
Track D7:
Track 08:

T
T
T
T
T
T
T
T

Format: Unknown
Channel: Unknown
Length: 0
Slip Audio:

Location Options
Yideo Path:

Audio Path:

Playback File Options

You can load a file (one file only) into your Playback window by simply dragging it from disk or
the After Effects CS5 bin to the active Playback window.

Playback: File Options

Select the File Options tab to see the file name and path currently pointing to the Video File
used for playback. Alternatively, you can click on the path hot-text to select a file, delete it using
the trash icon at the left, or turn it on/off using the check-box at the right.

You can select a color Look Up Table by clicking on the LUT hot-text, delete the existing LUT file
by clicking on the trash icon, or turn the file on/off in the check-box.
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Audio Files Setup - three audio enable check boxes, when checked, allow you to:

* Enable Audio Scrubbing - Audio will play while you move through frames using the
scrub bar (see Playback Controls).

* Enable Audio Variable Speed - Audio will play at the same speed the video is played
(rather than 1x only).

* Enable Audio Auto-Search - KONA software will automatically load the Audio Track list
with audio files generated with the same name as the selected video file.

Note: When Audio Auto-Search is active, existing file names in the list will be removed or
over-written when the Video File is loaded. (Does not affect the audio files.)

You can edit the Audio Track list that is automatically loaded with audio files that have been
generated with the same name as the selected video file.

QuickTime embedded audio files are automatically appended with a number and will be
loaded numerically into the track list. Click on the trash icon to delete a track. Click on the
speaker icon check-box on the right to enable/disable a track. To manually enter audio files,
simply double-click on a track in the list.

Format, Channel, and number of frames in the sequence are reported below the list.

Location Options - You can use the Video and Audio path hot-text fields to create a new
Playback directory (separate from your capture directory).

Playback: General Options

Under the General Options tab, you will find Device Control Options, Leader/Trailer Options,
and Memory Options.

Mlernar

Enfarce Mernory Alignrment

Device Control Options
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Device Control Options define the RS422 machine control interface on the KONA. These
functions support Print-to-Tape machine control.

Timecode Format - Use this pull-down to select the timecode base supported by your VTR.

* Base 24

* Base 25

* Base 25 (50 frames per second)

* Base 30 DF (drop-frame, 30 frames per second)

* Base 30 NDF (non-drop-frame, 30 frames per second)
* Base 30 DF (drop-frame, 60 frames per second)

* Base 30 NDF (non-drop-frame, 60 frames per second)

Timecode Source - Choose between a separate-channel Longitudinal Timecode (LTC) or
Vertical Interval Timecode (VITC) transported in the video signal’s vertical interval or
include both (LTC + VITC).

Click on the Hot-text items to enter a value for:

* Preroll - 0 to 15; the number of frames required to start the source machine before capture

* Timecode Offset — -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and that of the
captured sequence.

Leader/Trailer Options

These options allow you to add colorbars, test tone, and black field in a leader to your clip and
black field as trailer.

Memory Options

Under Memory Options, always leave Enforce Memory Alignment unchecked. It is for SATA
controller use only.
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Playback: KONA Options

The KONA Options for Playback are much the same as those for Capture. Playback options,
however, are for output.

<]

<]

=]

=]

<]

<]

<]

<]

=]

A

<]

u] 00:00:00:00 u] o
A SR :
o M :

Playback Screen with KONA Options menu

Activation Options
These are the same as for the Capture Plugin. See “Activation Mode” on page 76..

Playback Options

Primary Format, YUV-RGB Range, and Output type setting are all the same as those described
for the Capture window for Premiere Pro previously.

Audio Level
Choose between +6 dB (US) monitor level and +0 dB (EBU).
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Display to Desktop - Select one of four modes of desktop display:
* Off
* While Scrubbing Only (for best performance, this mode is suggested)
* While Playing Only
* Always

Note: Display to Desktop uses system resources and could affect performance during capture.

Play To Desktop Speed - Use this pull-down menu to set a desktop play speed:
* Full Speed - Every frame is displayed to desktop during playback
* Half Speed - Every other frame is displayed to desktop during playback
* Quarter Speed - one out of every four frames is displayed to the desktop

Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is using
to draw video to your computer.

Using the Reference pull-down menu, select timing Reference source—Free Run, from External
(genlock), or from the video Input signal.

The Mode option menu offers types of Playback—Edit or Output. This selection changes the
functionality of the Play Controls as described in the next section.

Play Controls The Mode selection made in KONA Options provides either editing or output functionality in
the Play Controls pane and in Output mode you can choose between Print-to-Video or Insert
Edit functionality.

Edit Mode
The Edit mode display is shown below:

Edit Mode Play Controls and Scrub Bar

Below the video display is a Scrub Bar that allows you to click and drag along the loaded
sequence to view individual frames and mark In and Out frames for playback of frame subsets.
To set an in-point, click on the left bracket. To set an out-point, click on the right bracket.

Alternatively, you can set an in-point by clicking on the left most hot-text numeral below the bar
and enter the desired frame number for an in-point. Similarly, enter the out-point frame by
clicking on the right side hot-text numeral.

Note: The “first” or “last” frame may be for the entire sequence or for frames in a in/out-marked
subset. In this case, first, last, in, and out frames become “Most Significant Frames.” For
example, clicking on the Go-to-1st button will move you to the first Most Significant Frame
to the left. Clicking on the Go-to-Next button will move you to the first Most Significant
Frame to the right.
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Immediately under the scrub bar are standard tape deck icons providing hot buttons for the
Play process. They are:

l4d  Go-to-Previous “Most Significant” frame M Reverse 1 frame
<44 Rewind (8x) 4 Reverse Play
sl B Stop

»  Play(1x) PP Fast Forward (8x)

M Forward 1 frame PPl Go-to-next “Most Significant” frame

The slider on the bottom is a variable speed forward/reverse control. Positions from left to
right are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8%, and 16x.

Output Mode Use the Mode pull-down at the bottom of the KONA Options tabbed menu
to select Output mode.

Note: The Playback Options pane is disabled in this mode to prevent format changes during
output.

Standard VTR controls and machine control timecode hot-text are provided for outputing
your segment. A pull-down menu beneath VTR Status allows you to choose between two
modes of output— Insert Edit or Print-To-Video. Print-To-Video and Insert Edit will output the
loaded clip from its in/out- points (if any exist) or from the first to last frame (if no in/out-
points are set).

Insert Edit Mode

In this mode, you can select the Video/Audio content that you want to insert by checking the
desired content boxes at the left. Then set an in-point that the recording VTR will use to
initiate recording of your segment. Duration is determined by the length of the clip you are
outputting.

WTR T ! 00;00;00;00 Cur: 00;00;00;01 Audin Level:

TR Status: Dizplay To Desktop:

Inzert Edit Play Ta D

Freview Edit o |TCutput
W1
Al
S

A2

Insert Edit Mode

Note: The Preview Edit check-box controls whether the insert edit is in “Preview” mode or
not. In preview mode, the deck never goes into record but just simulates the edit without
putting anything to tape. You must uncheck this box to perform the actual Insert Edit.
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Print-to-Video Mode

This mode allows you to manually put a clip to tape using the VTR’s current position. You have
the option of adding Delay frames. KONA will wait this many frames after the tape machine start
command before outputting the clip. The Duration Field displays the total length of the clip that
will go to tape. Click on the green hot button to launch the output sequence.

Delay (in Frames):

Cutput

Play Controls for Print-To-Video

Status Display The Status Display section above the Playback screen reports the settings that you have
selected for the KONA you are controlling:

* Primary Format
* Analog Output type

In the right column you will also see current information for:
* Playback Status: Stop, Still, Playing

Frames Dropped: a live frame count display followed by a total count of any frames dropped
from the sequence in parens ()
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Chapter 6: Using Combustion & Fusion

Using Autodesk Combustion 2008

AJA’'s KONA Plugins for Autodesk Combustion 2008 are used for Preview functions only.

Host |
General Framebuffer Type AJA Preview
Monitors
Mesh Options.
Capture
Framebuffer
Animation Use with RAM Player
Caching -
Behavior Update Dynamically
Colors
Grids & Guides g e
Transparency
Footage
General
Librar
Seqguence
Paint
General
Particles
General

Preferences “

Select AJA
Preview

Click
Overlay on Video Options

Board: 1 Type: Kona 3

OpenGL
General
Schematic
General

Cancel

Default

Combustion Preferences>Framebuffer Menu

The Preview Plugin allows you to view on a monitor the current project you are working on in
Combustion, at the KONA output. With a Combustion project open, go to
File>Preferences and select Host>Framebuffer. In the pull-down window, select
AJA Preview and click on Options to configure previews.
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If you use AJA’s Machina application for capture and your Video Input format is 8-bit YUV
4:2:2, then select the 2Vuy mode (uppercase V). Select Update Dynamically to output every
frame as you play a segment. Alternatively, you can output only the frame you have
stopped on and are currently viewing by deselecting Update Dynamically. This mode can
speed up processing by minimizing use of system resources.

Preview Options If you have more than one AJA capture device, the Board pull-down menu at the top allows
you to select the KONA to control (subject to Activation).

Note: Using multiple AJA capture devices in the same workstation is possible but not
always practical due to motherboard and disk system bandwidth limitations.

The Summary section reports current
configuration settings.

In Preview Options, you can change the
Primary and Secondary signal formats,
Convert mode, YUV to RGB range, SDI and
Analog output type (as applicable), and
select timing Reference mode—Free Run,
External (genlock), or from the video Input
signal.

In Color Options, you can change color
standards and view the resulting output
on your monitor. You can select a 10-bit
Look Up Table (LUT) file and turn it on and
off using the check-box at the right.

Prirnary Farrmat 14

M| Ao
Finally, for picture quality adjustment, you
can output a Test Pattern selection using s Nane
the pull-down menu under Test Options.
Click OK to output your Preview.

Maone
le Link 501
Single Link S0
Component SMPTE

Free Run

8-bit RGBA 4:4:4:4
S-bit RGEA 4:4:4:4

E01
Import LUT... Hene

Uzse LUT

T Dptions

Test Patterns i orBars

Upload Test Pattern

Ok

AJA Preview Setup Menu
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Activation Note: Only one plugin window can have control of the KONA card at a time. If the application
window you click on does not access the card (panel fields are inactive), either another
window is still processing operations or it may be in Manual activation mode and requires
manual disabling (check box blanked) to release control of KONA. Activation mode setup is
available in these applications:

* Machina
* Adobe After Effects CS5
* Adobe Photoshop CS5

Primary & The Primary Format menu allows you to select the video format to be used in the current project
Secondary Formats in the KONA framebuffer. (The current selection is reported in the display of the pull-down
menu.)

Choices are always presented based on which AJA capture device you are using and what signal
formats it supports. KONA supports video format up-, down-, and cross-conversions..

Primary Video Formats Supported

See “Selection of Primary & Secondary Formats ” on page 31 for video format and down-
conversion information.

SDI Output The SDI outputs will be Single Link only if there is no Secondary Video Output Format selected. If
you have a Secondary format selected, you can choose between Single Link SDI - Primary and
Single Link SDI - Secondary as your output. KONA 3 also supports Dual Link output.

On KONA LHi, there is only one SDI output, but there is an HDMI output. You can independently
configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E).

Analog Output Analog format choices in the Analog Output pull-down menu vary depending upon file format.
Choices that may be available include:
* Composite + S-Video NTSC * Composite PAL
* Composite + S-Video NTSC-J * S-Video PAL
* Component Betacam NTSC * Component Betacam PAL
* Component Betacam NTSC-J * Component SMPTE PAL
* Component SMPTE * Component RGB

¢ Component XVGA
(High Definition only)
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Using Eyeon Fusion

The KONA Fusion 6 plugin is a software application integrated into Fusion that allows you to
preview your current Fusion project from the KONA output. Go to File>Preferences to setup
AJA Preview. Note: KONA Software for Windows version 5 is for 64-bit Eyeon Fusion only.

Preferences

LISing prioxy -E||ir||;|

1 maintain apparent Fframe

[T Useimage cache

Selecting AJA Preview for Fusion
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Under Globals and new comp defaults->Preview select AJA Preview from the “Display file
sequences on:" pull-down menu. To set up AJA Preview formatting, continue down to the I/O
selections under Globals and new comp defaults and then choose AJA Preview.

np defaults

MNone

CGR

Component SMPTE

: Free Run

5: B-bit YUV 4:2:2

AVI

Import

Clear LUT

AJA Preview Setup Menu for Fusion

If there is more than one AJA capture device installed in your system, a pull-down menu at the
top allows you to select which device to control (subject to Activation rules).

In Preview Options, you can change the Primary and Secondary video signal formats and
Analog output type (as applicable), and select timing Reference mode—Free Run, External
(genlock), or from the video Input signal.

Finally, for picture quality adjustment, you can output a Test Pattern selection using the pull-
down menu under Test Options. Click OK to output your Preview.

Note: Fusion AJA Preview, in most cases, will not be in realtime for any RAM Preview.
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Activation Note: Only one plugin window can have control of the KONA card at a time. If the application
window you click on does not access the card (panel fields are inactive), either another
application is still processing operations or it may have a Manual activation mode and

must be disabled (check box blanked) to release control of the KONA. Activation Mode is
available in these applications:

¢ AJA’s Machina
¢ Adobe After Effects CS5
* Adobe Photoshop CS5

Primary & The Primary Format menu allows you to select the video format to be used in the current
Secondary Formats project in the KONA framebuffer. (The current selection is reported in the display of the pull-
down menu.) Secondary Format allows you to perform signal format conversions.

Choices are always presented based on which AJA capture device you are using and what
signal formats it supports.

Primary Video Formats Supported

Refer to “About Primary & Secondary Video Formats” on page 2 for detailed information on
video formats and conversions.



Chapter 7: 3rd-Party Applications

Native Support for KONA for PC Products

The following third-party applications provide native support for specified AJA KONA for PC
capture cards. This list is not all-inclusive. Other applications not listed may also support
KONA cards. If you have problems related to hardware functions while using these
applications, contact AJA Support and we will do our best to promptly verify and resolve
them. If your problems are software related please contact the application manufacturer.
Contact phone numbers and URLs are provided below.

Note: Some vendors may have a fee structure for customer support services.

KONA Card
Application Support Contacts
PP Supported PP
Avid Liquid Chrome LHe Note: Contact your Liquid Chrome dealer before contacting Avid
support.
Avid support:
1-800-800-2843
http://www.avid.com/onlinesupport/supportcenter.asp?productD=176
Sony Vegas KONA 3, LHi 1.800.577.6642
LSe/LS http://www.sonycreativesoftware.com/support/technicalsupport.asp
Drastic Technologies KONA 3, LHi 1-416-255-5636
Media NXS LSe email: support@drastictech.com
Sonic CineVision LHe 1-866-279-7694 (toll free) or 1-905-482-5200 outside of North America
(Note: This is a call to the Toronto area and you are responsible for any
toll fees that may apply.)
http://www.sonic.com/about/contactus.aspx
CineForm KONA 3, LHi http://supportcenteronline.com/ics/support/default.asp?deptiD=614
Prospect HD, Prospect 4K,
Neo HD, & Neo 4K
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Using KONA with
Avid Liquid
Chrome™ XE

Sony Vegas + DVD

Drastic
Technologies
Media NXS

Sonic CineVision

CineForm
Prospect & Neo

The Avid Liquid Chrome XE product comes bundled with a KONA LHe card for media
capture and playback. No AJA plug-ins are necessary for Liquid Chrome operation—
however, for you to use other applications (including Machina)with KONA, you will need to
install the necessary KONA pluggins and drivers using the supplied AJA software CD.

Sony Vegas + DVD Production Suite support for KONA 3, LHe, and LSe/LS cards allows you
to capture, edit, monitor, and print-to-tape using SDI (serial digital interface) professional
SD and HD decks. Multichannel audio, mixed timecode handling, 1080 24p capture and
export, and component monitoring are also supported.

Additionally, the combination of Sony Vegas 9 and AJA KONA cards allows users to capture
MXF files in Sony’s 50 Mb/s HD MPEG 4:2:2 format which is analogous to the XDCam EX
format. This is great for compressed offline or online editing, or for archiving video in a very
small, yet high-quality file.

The Media NXS software-based digital disk recorder application supports KONA 3, LHi, and
LSe/LS cards for uncompressed capture and playback. Media NXS supports a wide range of
hardware platforms including Uncompressed 8/10-Bit Y'CrCb and video standards ranging
from NTSC/PAL to 1080x1920 HDTV.

Sonic CineVision is a comprehensive encoding solution for the Blu-ray Disc and HD DVD
optical disc formats. It supports a wide range of file and image sequence input files.
CineVision offers complete support for all three next-generation video codecs—H.264/AVC,
VC-1 and MPEG-2. AJA's KONA LHe card is a CineVision recommended peripheral for
uncompressed capture/playback.

Note: For users who want to use both the CineForm Premiere Pro plugins for compressed
workflow and the KONA Premiere Pro plugins for uncompressed workflow:

Because the CineForm Prospect HD plugins are dependent on older versions of the AJA
Hardware drivers, it is necessary to have a dual-boot configuration if both Prospec/Neo and
KONA plugins will be used. The KONA plugins must be installed on one bootable partition,
and the CineForm plugins installed on the other.



Appendix A: Troubleshooting

If You Run Into Problems

Updating Software

Support

One useful way to find the source of problems is to isolate your system to the smallest size
where the problem still occurs and then note all the symptomes. This serves to eliminate areas
not involved in the problem and makes finding the problem easier.

Once you've noted problem symptoms, look through the following table and see if any of the
symptoms are listed. If so, check the items listed. If you later need to call for customer service,
let them know all of the things you've tried and when and how the symptoms appeared.

Check for software updates on the AJA Video website:
http://www.aja.com/support/index.php

If any are available, download the file and read any associated instructions prior to installing
the software.

When calling for support, first check over your system configuration and ensure everything is
connected properly and that current Final Cut presets and Easy Setups match what you are
trying to do. Even if you cannot find the cause of the problem, having this information at hand
will help when you call Apple or AJA Customer Support for help.

If the problem is unknown or you need general help, first contact the dealer where you
purchased the product. AJA dealers offer product support for many service requirements.

If the problem is a Final Cut Pro operational issue, Mac Pro system issue, or Xserve RAID issue,
then call Apple Customer Support for help.

If the problem is an AJA Video KONA issue, contact AJA Video Customer Support using one of
the methods listed below:

Contacting by Mail Address:

180 Litton Drive, Grass Valley, CA. 95945 USA
Telephone: 1.800.251.4224 or 1.530.274.2048
Fax: 1.530.274.9442

Web: http://www.aja.com
Support Email: support@aja.com
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Frequently Asked Questions

Can | use SATA Drives for RAID storage with the KONA product line?

AJA always recommends the use of SCSI or Fibre Channel storage solutions for use with
KONA products.

| updated the KONA software and my KONA hardware is now missing,
Why?

A function of the uninstaller is removing the current driver for the KONA card. In doing this
the KONA hardware is removed completely. A “plug and play” request must be made to
install a new driver for the hardware. This can be done be either restarting the system or
going into device manager and searching for new hardware. On startup the computer
automatically looks for new or uninstalled hardware.

Can the KONA handle HDV, P2, XDCam, or AVCHD? If so how?

HDV, XDCam, P2, and AVCHD files will play real-time in Premiere Pro when using AJA
supplied project presets. Alternatively, you can use KONA to capture uncompressed from
these cameras if they have SDI, HDMI, or Analog outputs.

Does KONA Offer Support for compressed codecs?

All KONA cards can capture DV 25 and DV 50 compressed QuickTime files from analog and
digital sources through their available inputs. KONA LHi and KONA 3 can also capture
DVCProHD compressed QuickTime files for HD resolutions. Please see our DVCProHD white
papers (see the whitepaper DVCProHD Editing with KONA and KONA at

http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf).

| am using After Effects for compositing and sometimes my preview is
not in real time—why is this?

RAM Preview should be very close to real-time for HD in After Effects 7. Please ensure you
have the following settings for proper RT RAM preview.

1. Make sure that the “Primary Format” of the AJA Preview Panel in AE7 matches the
resolution and frame rate of your After Effects Composition.

2. Also, RT RAM Preview is only possible with 8-bit AE Projects and with the “8-bit RGBA
4:4:4:4" setting for the “Output 8-bit As:” found in the AJA Preview Panel Color
Options. Other color spaces and AE Project depths require a software transformation
of the video data before being displayed—thus slowing down preview.

3. Next, please ensure that the “Resolution” setting for “Time Controls” is set to “Full”. If
not set to “Full’the image that the AJA Preview Panel receives and sends to the
KONA board during RAM Preview will not be sent at “Full Resolution” and thus will
either be software resized to Full Resolution before sending to the KONA Board for
display, or will be center cropped before sending. The latter choice is controlled by
the checkbox in the AJA Preview Panel labeled “Auto Resize Image” under the
“Primary Format” Setting.

4. If RAM Preview is still not real-time, you can try some of the following - setting your
Zoom to “100%" in your AE Composition, making sure the “Frame Rate” of the AE
Time Controls” matches the frame rate of the “Primary Format” in the AJA Preview
Panel, and muting audio in the AE Time Controls.
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Note: In some cases the available bandwidth of the motherboard limits the cards ability
to output full frame rate 1080i 29.97 RGBA.

How does KONA hardware Up-convert, Cross-convert or Down-con-
vert?

The KONA 3 and LHi can perform many different conversions of a video source. They can
convert only when video is passing across the board. So in capture or playback you have
the ability to convert video in hardware in real-time with no CPU/Memory cost.

Can | work with 720p variable frame rates?

KONA will automatically remove duplicate frames from varicam footage as long as the
RP-188 flags are set correctly. However, this footage will have 29.97 fps timecode. KONA
does not attempt time code conversion, so the timecode in captured files will not be

reliable.

What file formats are supported by KONA?

We support the following formats:

AVl files in the following Subtypes

QuickTime files in the following Subtypes

8-Bit YUV 4:2:2 - “2vuy’

8-Bit YUV 4:2:2 - "2Vuy’

8-Bit YUV 4:2:2 - ‘uyvy’

8-Bit YUV 4:2:2 - 'v210’

8-Bit RGB 4:4:4 - 'bgr’

8-Bit RGB 4:4:4:4 - 'bgra’
8-Bit RGB 4:4:4 - 'bgr’ T2B
8-Bit RGB 4:4:4:4 — 'bgra’ T2B
10-Bit Log RGB 4:4:4 - 'R10g’
10-Bit RGB 4:4:4 - ‘R10k’
10-Bit RGB 4:4:4 — 'r10k’

8-Bit YUV 4:2:2 - “2vuy’
8-Bit YUV 4:2:2 - 2Vuy’
8-Bit YUV 4:2:2 - 'v210’
8-Bit RGB 4:4:4 - 'rgb’
8-Bit RGB 4:4:4 - 'bgr’
8-Bit RGB 4:4:4:4 - ‘argb’
8-Bit RGB 4:4:4:4 - 'bgra’
8-Bit RGB 4:4:4:4 — 'rgba’
10-Bit Log RGB 4:4:4 - 'R10g’
10-Bit RGB 4:4:4 - ‘R10k’
10-Bit RGB 4:4:4 - r10k’

DPX Sequences in the following Subtypes

Cineon Sequences in the following Subtypes

10-Bit Log RGB 4:4:4 (BE) T2B
10-Bit RGB 4:4:4 (BE) T2B
10-Bit Log RGB 4:4:4 (BE) B2T
10-Bit RGB 4:4:4 (BE) B2T
10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

10-Bit Log RGB 4:4:4 (BE)

TGA Sequences in the following Subtypes

BMP Sequences in the following Subtypes

8-Bit RGB 4:4:4 B2T
8-Bit RGB 4:4:4:4 B2T
8-Bit RGB 4:4:4 T2B
8-Bit RGB 4:4:4:4 T2B

8-Bit RGB 4:4:4 B2T
8-Bit RGB 4:4:4:4 B2T
8-Bit RGB 4:4:4 T2B
8-Bit RGB 4:4:4:4 T2B

TIF Sequences in the following Subtypes

YUV Sequences in the following Subtypes

8-Bit RGB 4:4:4(LE) B2T
8-Bit RGB 4:4:4:4(LE) B2T
8-Bit RGB 4:4:4(LE) T2B
8-Bit RGB 4:4:4:4(LE) T2B
8-Bit RGB 4:4:4(BE) B2T
8-Bit RGB 4:4:4:4(BE) B2T
8-Bit RGB 4:4:4(BE) T2B
8-Bit RGB 4:4:4:4(BE) T2B

8-Bit YUV 4:2:2
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Are there any important things to be aware of when setting up a RAID
for Video capture?

Many SCSI and Fiber raids that use SATA or IDE with a backplane and controller often offer
user settings for configurations. Be sure to format the Physical disk in a 512 Block size and
never exceed a single volume size of 2TB. Multiple 2TB (or below) can be striped together by
the OS for larger capacity storage.

| captured a QuickTime file and then renamed it when the system
prompted me to save it—why did it take so long to save?

When KONA is capturing, it creates separate audio & video files based on the name the clip
is logged with and then multiplexes the audio & video together at the end of the capture. If
the user renames this clip after the capture, a duplicate clip has to be regenerated and re-
multiplexed.

I have KONA software version 2.5 or later installed, and now my desk-
top display is very blocky—why is this?

In version 2.5 we added support for OpenGL Texture desktop display. For OpenGL Texture
support, an NVidia Quadro FX card with version 91.36 software or later is required.

How do | ensure I've done a full uninstall of the KONA software?
1. In “Add / Remove Programs” uninstall the KONA Retail.
2. Uninstall the AJA Video for Windows Codec and the AJA KONA Drivers.

3. Restart and go to program files, and then verify there are no AJA folders or files
named KONA in the following directories:

* C:\Program Files\Adobe\Adobe After Effects CS5\Support Files\Plug-ins

* C:\Program Files\Adobe\Adobe Premiere Pro CS5\Plug-ins\en_US

* C:\Program Files\Adobe\Adobe Premiere Pro CS5\Settings\en_US

* C:\Program Files\Adobe\Adobe Premiere Pro CS5\Plug-ins\en_US\Editing Modes
* C:\Program Files\Adobe\Common\Plug-ins\CS5\Media Core\

* C:\Program Files\Adobe\Adobe Photoshop CS5\Plug-Ins\import-Export

* C:\Program Files\Autodesk\Combustion 2008\Plugins\Discreet\Modules

* C:\Program Files\eyeon\fusion 5.x\plugins



Appendix B: Specifications

KONA 3 & 3x Specifications

KONA 3
PCle 4-lane compatible

KONA 3x
PCle and PCI-X compatible

Video Formats

SD:
525i29.97
525i 29.97 (WIDE)
625i 25
625i 25 (WIDE)
480i 29.97
480i 29.97 (WIDE)

HD:
720p 23.976
720p 24
720p 29.97
720p 30
720p 50
720p 59.94
720p 60
1080i 25
1080i 29.97
1080i 30
1080p 23.98
1080psf 23.98
1080p 24
1080psf 24
1080p 25
1080psf 25
1080p 29.97
1080psf 29.97
1080p 30
1080psf 30
1080p 50
1080p 59.94
1080p 60

2K:
2048 x 1080p 23.976
2048 x 1080psf 23.976
2048 x 1080p 24
2048 x 1080psf 24
2048 x 1556p 14.98
2048 x 1556p 15
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Video Input

HD-SDI/SDI, SMPTE-259/292/296

Dual-link HD 4:4:4

2K HSDL Video Output

Digital:
HD-SDI/SDI, SMPTE-259/292/296
Dual-link HD 4:4:4
2K HSDL

Analog:
SD and HD Output, 12 bits, BNC
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
12-bit D/A

Audio
16/24/32-bit 48 kHz synchronous
16-channel SDI/HD-SDI embedded audio
sample rate conversion on AES inputs
(no source synchronization required)

Up-Conversion
Hardware 10-bit
Aspect conversion modes:
Anamorphic - full-screen
Pillar box 4:3 - results in a 4:3 image in
center of screen with black sidebars
Zoom 14:9 - results in a 4:3 image zoomed
slightly to fill a 14:9 image with black sidebars
Zoom Letterbox — zooms a 16:9 Letterbox source
to full-screen
Zoom Wide - results in a combination of zoom and
horizontal stretch to fill a 16:9 screen; this setting
can introduce a small aspect ratio change

Down-Conversion
Hardware 10-bit
Anamorphic - full-screen
Letterbox - 16:9 image with black top and bottom
Crop - image is cropped for full-screen image

Cross-Conversion
Hardware 10-bit
1080i to 720p
720p to 1080i

SD to SD Aspect Ratio Conversion
16:9 to 4:3 Letterbox
16:9 to 4:3 Horizontal Crop
4:3 to 16:9 Pillarbox
4:3 to 16:9 Vertical Crop

Reference Input
Analog Color or HD Tri-level
1 BNC on standard breakout cable
(75 Ohm terminating)

Machine Control
RS-422, Sony 9-pin protocol



KONA LHi Specifications

KONA LHi
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PCle 4-lane compatible

Look Up Tables

Real-time primary LUT
Import/export text-based LUT files

File Import/Export

Import (capture) and export (playback) standard
file formats: DPX, Cineon, TGA, TIFF,
BMP, and AVI,QuickTime.

Video Formats
SD:

HD:

Video Input
Digital:

Analog:

525i29.97
625i 25

720p 23.976
720p 24

720p 25

720p 29.97
720p 30

720p 50

720p 59.94
720p 60

1080i 25
1080i 29.97
1080i 30
1080p 23.976
1080psf 23.976
1080p 24
1080psf 24
1080p 25
1080psf 25
1080p 29.97
1080psf 29.97
1080p50, 59.94, 60
1080p 30
1080psf 30

HD-SDI/SDI, SMPTE-259/292/296
HD-SDI 1.5Gb and 3Gb
HDMI v1.3, 30 bits/pixel,
RGB or YUV, 2.25Gbs, SD, HD, 1080p50/60

SD and HD Input, BNC

HD: YPbPr, RGB

SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
12-bit A/D
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Video Output
SD and HD Output, BNC
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
12-bit D/A
HD-SDI 1.5Gb and 3Gb
HDMI v1.3, 30 bits/pixel,
RGB or YUV, 2.25Gbs, SD, HD, 1080p50/60

Audio Input
Digital:
2-channel 16/24/32-bit AES/EBU, 48 kHz sample rate
Synchronous or Non-synchronous
(Internal sample rate conversion)
16/24/32-bit SMPTE-259 SDI embedded audio, 8-Ch, 48 kHz synchronous
Analog:
2-channel balanced input
+24dbu Full-scale Digital (0dbFS)
16/24/32-bit D/A, 48 kHz sample rate
+/- 0.2db 20 to 20 kHz Frequency Response

Audio Output
Digital:
2-channel 16/24/32-bit AES/EBU, 48 kHz sample rate
16/24/32-bit AES/EBU, 48 kHz sample rate
16/24/32-bit SMPTE-259 SDI embedded audio, 8-Ch, 48 kHz synchronous
Analog:
2-channel balanced output
+24dbu Full-scale Digital (0dbFS), 16/24/32-bit D/A, 48 kHz sample rate
+/- 0.2db 20 to 20 kHz Frequency Response

Up-Conversion
Hardware 10-bit
Aspect conversion modes:
Anamorphic - full-screen
Pillar box 4:3 - results in a 4:3 image in
center of screen with black sidebars
Zoom 14:9 - results in a 4:3 image zoomed
slightly to fill a 14:9 image with black sidebars
Zoom Letterbox — zooms a 16:9 Letterbox source
to full-screen
Zoom Wide - results in a combination of zoom and
horizontal stretch to fill a 16:9 screen; this setting
can introduce a small aspect ratio change

Down-Conversion
Hardware 10-bit output, 16/24/32-bit internal processing
Anamorphic - full-screen
Letterbox - image is reduced with black top and bottom added
to image area with the aspect ratio preserved
Crop - image is cropped horizontally



Installation and Operation Manual — KONA LSe Specifications [

Cross-Conversion
Hardware 10-bit
1080i to 720p, 720p to 1080i

SD to SD Aspect Ratio Conversion
16:9 to 4:3 Letterbox
16:9 to 4:3 Horizontal Crop
4:3 to 16:9 Pillarbox
4:3 to 16:9 Vertical Crop

Reference Input
Analog Color or HD Tri-level
1 BNC on standard breakout cable (75 Ohm terminating)
KLHI-Box (optional): 2 BNCs, passive loop
BNC assignable as LTC input

Machine Control
RS-422, Sony 9-pin protocol
Connector provided on KONA LHi breakout cable and on optional KLHI-Box.

KONA LSe Specifications

KONA LSe
PCle compatible

File Import/Export
Import (capture) and export (playback) standard
file formats:TGA, TIFF, BMP, and AV,
QuickTime, WAV.

Video Formats

SD:
525i29.97
625i 25
Video Input
Digital:

8 or 10-bit SDI, SMPTE-259
Analog:

SD: YPbPr, RGB (component mode)

Composite/YC (composite mode)

12-bit A/D

Video Output
Digital:
8 or 10-bit SDI x2 BNC, SMPTE-259
Analog:
SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
12-bit A/D
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Audio Input
Digital:

Analog:

Audio Output
Digital:

Analog:

Reference Input

2-channel 16/24/32-bit AES/EBU, 48 kHz sample rate

Synchronous or Aynchronous

(Internal sample rate conversion)

16/24/32-bit SMPTE-259 SDI embedded audio, 6-Ch, 48 kHz synchronous

2-channel balanced input

+24dbu Full-scale Digital (0dbFS)
16/24/32-bit A/D, 48 kHz sample rate

+/- 0.2db 20 to 20 kHz Frequency Response

2-channel 16/24/32-bit AES/EBU, 48 kHz sample rate
16/24/32-bit SMPTE-259 SDI embedded audio, 6-Ch, 48 kHz synchronous

2-channel balanced output (XLR)

+24dbu Full-scale Digital (0dbFS)

16/24/32-bit D/A, 48 kHz sample rate

+/- 0.2db 20 to 20 kHz Frequency Response

2-channel unbalanced output (RCA-jack): requires KL-Box option

Analog Color Black
1 BNC on standard breakout cable (75 Ohm terminating)
KL-Box (optional): 2 BNCs, passive loop

Machine Control

RS-422, Sony 9-pin protocol
Connector provided on KONA LS breakout cable and on optional KL-Box.

Machine Control Connector Pinout

RS-422, Sony 9-pin protocol. 9-pin D-connector pinout is as follows:

GND
RX-
TX+
GND

No Connection

RX+
TX-
GND

1
2
3
4
5
6 GND
7
8
9
Shell GND
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